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Get Help

Get Help in the Applications

Use help icons ® to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You can
join forums to connect with other customers, post questions, and watch events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Introduction

Overview of Implementing Talent Review and Succession
Management

This guide explains the setup and implementation tasks of Oracle Fusion Talent Review and Succession Management
Cloud Service. Using the tasks described in this guide, you can:

- Configure Talent Review settings

- Create Talent Review templates

- Manage potential assessments

- Set up talent review meetings

- Configure Succession Management lookups

Oracle Fusion Talent Review and Succession Management Cloud Service is part of the Workforce

Development offering of Oracle Human Capital Management Cloud. To start an implementation of

Oracle Human Capital Management Cloud, a user with the Application Implementation Consultant role
(ORA_ASM_APPLICATION_IMPLEMENTATION_CONSULTANT_JOB) must opt into the offerings applicable to your
business requirements. Refer to the Oracle Applications Cloud Using Functional Setup Manager guide to manage the
opt-in and setup of your offerings.

This topic:

- Lists where to find information about prerequisite tasks and pertinent information about implementing Oracle
Fusion Talent Review and Succession Management Cloud

- Describes the Talent Review and Succession Management functional areas of the Workforce Development
offering

Prerequisites

Before setting up Oracle Fusion Talent Review and Succession Management Cloud Service you must implement either:
- HCM Base
- Talent Management Base

You are also required to configure other applications and elements. The table lists sources of information, including
guides and help topics, and a description of what they contain, to help you set up the configuration that fits your
business needs and processes.

Source Contents

Oracle HCM Cloud Getting Started with Provides an overview of Talent Management Cloud options, purchasing and activation options, basic
Oracle Talent Management Cloud information for implementing Talent Management applications, and describes work areas

Oracle Talent Management Cloud Describes user and role synchronization, implementation user setup, enterprise and workforce
Implementing Talent Management Base structures, workforce profiles, approvals, help configuration, and more

ORACLE
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Source Contents
Oracle Global Human Resources Cloud Describes user and role synchronization, implementation user setup, enterprise and workforce
Implementing Global Human Resources structures, workforce profiles, approvals, help configuration, and more
Human Capital Management Cloud Describes Oracle Human Management Cloud security, types of roles and how to create them,
Securing Oracle HCM Cloud managing user accounts, types of security profiles and managing them, and Oracle Fusion

Transactional Business Intelligence and Business Intelligence Publisher security

Workforce Development Offering

Use this offering to configure your employee profiles, manage goals, review performance, and manage succession
plans. The following table describes the primary features of this offering that are explained in this guide. For the full list
of functional areas and features in this offering, use the Associated Features report that you review when you plan the
implementation of your offering.

Functional Area Description

Talent Review Use this to conduct talent review meetings, and assess employee performance and progress. You can
associate succession plans and talent pools with a talent review meeting. You can also assign tasks to
the meeting reviewees and create notes about the meeting.

Succession Management Use this to create and manage succession plans for key personnel or incumbents in important jobs or
positions. You can also add notes to succession plans.

Related Topics
 Planning Your Implementation: Procedure

Guide Structure

This guide explains the setup and implementation tasks of Oracle Fusion Talent Review and Succession Management
Cloud Service.

This topic describes the contents of each chapter included in the following sections of the guide:

« Introduction

- Talent Review

« Succession Management
- Talent Pools

- Personalization Using Transaction Design Studio

Introduction
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Chapter

Talent Review

Chapter

Title

Introduction

Title

Talent Review Overview and
Integrations

Talent Review Profile Options and
Descriptive Flexfields

Talent Review Templates

Potential Assessment

Talent Review Tasks and Notes

Succession Management

Chapter

ORACLE

Title

Succession Management

Contents

Chapter 1
Introduction

An overview of Oracle Fusion Talent Review and
Succession Management implementation and
description of the guide structure

Task

Manage Talent Review Profile
Option Values

Manage Talent Review Descriptive
Flexfields

Configure Talent Review
Dashboard Options

Manage Potential Assessment

Manage Talent Review Lookups

Manage Talent Review
Notifications

Task

Manage Succession Management
Lookups

Contents

An overview of Oracle Fusion

Talent Review and description
of how it integrates with other
applications

Describes the consequences of
setting up the talent review profile
option and defining a segment for
a descriptive flexfield for Talent
Review

Describes how to create talent
review templates and configure the
box chart matrix

Provides an overview of the
potential assessment and
describes how to configure it

Provides an overview of talent
review tasks and notes and how to
use them

Contents

Overview of succession
management

Describes how succession
plans, talent pools, and talent
reviews work together

Overview of succession
management lookups and
descriptive flexfields
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Chapter Title Task

Chapter 1
Introduction

Contents

Describes how the user
can configure alerts for
succession plans

Explains how you can use
succession plan related deep
links

Describes how you can add
an object note to a succession

plan
Talent Pools
Chapter Title Task Contents
8 Talent Pools Manage Descriptive Flexfields - Overview of talent pools

Personalization Using Transaction Design Studio

Chapter Title
9 Personalization Using Transaction Design
Studio

ORACLE
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related descriptive flexfields

- Explains how you can use
talent pool related deep links

Contents

Explains the actions to use in Transaction
Design Studio to configure Talent Review,
Succession Management, and Talent Pool
pages.
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2 Talent Review Overview and Integrations

Talent Review

The talent review process involves one or more talent review meetings. Its purpose is to evaluate workers who are part
of the review population, assess their strengths, and address areas of risk for the organization.

Use the Talent Review work area to create, edit, and conduct talent review meetings. Select My Client Groups > Talent
Review to access this work area.

Talent Review Stakeholders

This image shows the stakeholders of a talent review meeting.

Talent Review

Facilitators

t @
Ak AA

& I/ .
n . Participants

s

- - -~ ™ =
Tl
| n I u Review Population

This table lists what facilitators and participants do in a talent review meeting.

Stakeholder Who They Are What They Can Do Comments
Facilitators - Human resource (HR) - Manage and conduct the - Goals created in a Talent
specialist (or other HR meeting. Review meeting are
business partner) automatically assigned to the
o . + Add development and worker as an individual goal.
Organizational business performance goals for the

The worker or manager can
view the goal in the worker's
goal page.

leader review population.
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Stakeholder Who They Are

What They Can Do
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Comments

Line managers .

- Create tasks for the review
population.

- Create notes about the
meeting.

- Add workers in the talent
review meeting dashboard to
talent pools and succession
plans.

- Create talent pools and
succession plans for the
meeting.

Review worker profile,
performance, goals, and
compensation data before the
meeting starts.

- Calibrate ratings of the review

You track tasks to completion
using the Tasks page.

You can review worker ratings for
any level of the organization. For
example, you can review workers in
an organization as a single group.
Or, you can filter workers by job,
location, or other categories.

Worker Ratings

population.

View worker data, such as
competencies and degrees in
the worker's person spotlight.

As a meeting participant, you can review the ratings of workers to understand worker strengths and weaknesses. You

can view any of these ratings on the box chart matrix:

- Performance

- Potential

- Overall competencies
- Overall goals

- Impact of loss

- Risk of loss

- Talent score

You can configure the box chart views and combine the ratings to review data critical to your business process. You can
switch from one view to another and can rate the workers using different criteria on the alternate view.

Any rating updates from the meeting appear in the worker profile data. You can identify them as talent review ratings to
distinguish them from other ratings, such those from a performance evaluation.

Talent Review Deep Links

You can use deep links to navigate directly to the Talent Review pages indicated in this table.

Deep Link Navigates To

Overview (HR_TALENT_REVIEW_
OVERVIEW)

ORACLE
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Deep Link Navigates To
Overview (MGR_TALENT_REVIEW_ Manager Talent Review Meetings page
OVERVIEW)

Related Topics

« Succession Management

» How Succession Plans, Talent Pools, and Talent Reviews Work Together
- Talent Pools

- Talent Review Life Cycle

Talent Review Life Cycle

The talent review process includes tasks from creating the meeting template through conducting the review meeting
to managing notes and tasks created for the meeting. Manage talent reviews in the Talent Review work area. Select My
Client Groups > Talent Review .

This image shows the different stages of the talent review process and identifies responsibilities.
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Talent Review Lifecycle
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Let's now see what each stage involves.

Create Talent Review Template

Chapter 2
Talent Review Overview and Integrations

The human resource (HR) specialist creates a talent review template in the Setup and Maintenance work area.
Facilitators can use the same template for many talent reviews. In the template, the HR specialist can specify these

attributes of a meeting:

- The size of the review population
- The box-chart matrix options and default presentation
- The data available to meeting participants

- The actions that participants can perform

The HR specialist can also indicate if the review can include succession plans and talent pools.
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Create a Meeting

Meeting facilitators, who have the HR specialist role can create talent review meetings. A meeting can have multiple
facilitators, any of whom can perform these tasks when creating a meeting:

1. Select a talent review template.

2. Schedule the meeting.

3. Select the content available for reviewers to prepare before the meeting, from the options specified in the talent
review template.

4. Select meeting participants and designate them as either reviewers or participants who act as observers.

5. Identify the review population.

When a facilitator submits the meeting configuration, if New meeting scheduled notification is enabled, the
participants receive notifications to prepare review content for the meeting.

Prepare Review Content

Participants who are designated as reviewers submit content for their direct and indirect reports before the meeting is
conducted. The content can include ratings for these profile data:

- Performance

- Potential

« Overall competencies
- Overall goals

- Impact of loss

- Risk of loss

- Talent score

Reviewers can grant access to other managers below them in their hierarchy to submit data for their own direct reports.
When reviewers submit the data, any changes to the ratings appear in the profiles of reviewed workers.

These talent review notifications can be enabled for tracking content submission:

- Talent review content preparation reminder notification: Facilitators can send reminder notifications to
reviewers when the submission deadline approaches.

- Submit talent review meeting content notification: Facilitators receive a notification when reviewers submit
their ratings.

Conduct the Talent Review Meeting

The facilitator starts the meeting in the Talent Review work area. During the meeting, participants provide information
about the worker ratings. The facilitator then calibrates the ratings on the dashboard.

Workers in the review population who weren't assessed before the facilitator started the meeting appear in the meeting
Holding Area, if it's available.

The facilitator, after consulting with the participants can perform any of these actions during the meeting:

- View and update the meeting box chart.

- Review profile and compensation details of individual workers in the review population on the worker's person
spotlight.

ORACLE



Talent Management Cloud Chapter 2
Implementing Talent Review and Succession Management Talent Review Overview and Integrations

- Compare current data to that from previous meetings.
- Compare a worker to another worker or to a job profile.
- Open the organization chart of the organization that's being reviewed.

- Add workers in the review population to talent pools or succession plans, if the pools and plans are included in
the meeting template.

Move workers in the review population from the box chart to the Holding Area or from the Holding Area to the
box chart.

- Assign performance and development goals to workers.
- Assign tasks to anyone in the organization.
- Create notes for workers in the review population.

- Save the meeting or submit it to freeze the data.

Note: Facilitators can perform actions depending on the meeting template configuration.

These are the consequences of a facilitator saving the meeting data:

- Goals, notes, and tasks are saved immediately.
- Workers can access performance goals assigned to them from their goal management pages, and manage
development goals from their career development pages.

When the facilitator submits the meeting data, any profile changes appear in the worker's profile record.

Manage Notes and Tasks

Facilitators can manage and monitor notes and tasks added in meetings, and review them for all workers for all
meetings.

Related Topics
« Talent Review Template

 Guidelines for Selecting Participants for Talent Reviews
« How You Prepare Content for a Talent Review Meeting

How Talent Review Works with Profiles, Goals, and
Performance Management

Talent review integrates with Profiles, Goals Management, and Performance Management. You use talent review
templates to control this integration. Create talent review templates on the Manage Talent Review Templates page. In
the Setup and Maintenance work area, use the following:

- Offering: Workforce Development
Functional Area: Talent Review

- Task: Configure Talent Review Dashboard Options

10
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This image shows the data integration of Talent Review with Profiles, Goals Management, and Performance

Management.

Performance
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Goals Library

Performance
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Development
Goals

Goals
Management

Talent Review and Profiles

Ratings

-—

Performance

Development
Goals

Talent Review

Profiles
Performance
Documents
Ratings
and
Rating Overall Ratings,
Models Cwverall Goals,
and
Owverall

Competencies

-+ Performance
Management

Owverall Ratings,
Ovwverall Goals,
and
Cwerall
Competencies

You can include any of these ratings and their associated rating models from Profiles in a talent review template:

- Performance

- Potential

- Overall Competencies Rating

- Overall Goals Rating

- Impact of Loss
- Risk of Loss
- Talent Score

Reviewers rate the review population based on the ratings included in the template. When a facilitator conducts the
meeting, the participants can view the ratings of each worker in the review population on the meeting dashboard. The
facilitator can show how the latest ratings compare with the prior ratings of the workers stored in profiles.

The latest overall performance rating for a worker can come from any of these sources:

- Overall rating in the performance document

ORACLE
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Rating that a participant provides while preparing the review content before the meeting

- Career Planning card

The facilitator can change the ratings of the workers during the meeting. When the facilitator submits the meeting, the
ratings of the workers in the review population is updated in Profiles.

Talent Review and Goals

A facilitator can assign a performance goal or a development goal to a worker in the review population while conducting
a Talent Review meeting. A facilitator can assign a new goal or an existing goal from the goal library. Workers can view
the goals assigned on their performance goal or development goal pages.

Talent Review and Performance Management

You can enable ratings for the performance document sections. If the performance document is configured to do so,
when a performance document is completed, the worker's profile is updated to include these changes made in the
performance document:

- Overall ratings
- Competencies and proficiency rating levels

- Competencies and goals section ratings

When the ratings are enabled, you can configure the talent review template to include overall worker competencies,
overall ratings, and overall goals ratings

Related Topics
» Update Existing Setup Data

 Oracle Fusion Profile Management Components: How They Work Together
- Rating Models
» Goal Library

Deep Links

You can use deep links to provide easy navigation directly to a page in the HCM Cloud application. Deep links can also
be used for mobile responsive pages on your intranet, custom and third-party applications, or in a document. This helps
people run transactions in the HCM cloud and provides quick access to their HR information.

To access deep links:

1. Open the main menu.
2. Goto Tools > Deep Links .
3. Copy the URL for a deep link.
4. Paste the URL in the desired location.
When you open Deep Links, you will find a list of all available deep links.

12
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Configure a Talent Review Box Assignment Event to
Trigger Checklist Tasks

This example shows how to use the condition builder to configure the Box Assignment checklist event. Let's assume
that you want line managers to do these tasks when a member of the review population moves to the Top Talent box
on the Talent Review dashboard:

Include the member in a particular talent pool.
- Add some development goals for the member.

You need to do these tasks to configure the Box Assignment checklist event:

1. Create a Talent Review Box Assignment checklist template.
2. Configure the Box Assignment event.
3. Add tasks for the manager.

Create a Talent Review Box Assignment Checklist Template
1. In Setup and Maintenance, go to the Checklist Templates task.
I Tip: You can also use the Checklist Templates quick action available in My Client Groups.

2. Create a checklist template.
3. On the General tab, specify values as indicated in this table.

Field Value

Name Talent Review Box Assignment

Status Active

Category A suitable category. For example, Talent Management.
4. Click Save.

Configure the Box Assignment Event

Click the Actions and Events tab.

In the Configure Events section, click Add.

Select Box Assignment in the Name list of values.
Click Edit Condition to display the Condition Builder.
Click Create Group.

A WN

13
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6. Select the values indicated in this table.

Condition Column

Attribute

Operator

Operand Type

Operand Value

Value to Select

Box Assignment Name

Equals

Constant

Top Talent

Note:

Chapter 2
Talent Review Overview and Integrations

The values listed depend on the box assignment values configured in the Talent Review

meeting template.

7. Click OK to close the Condition Builder.

8. C(lick Save.

Add Tasks for the Manager

1. Click the Tasks tab.
2. Click Add Task to add a task.

3. On the Details sub tab, specify values as indicated in this table.

Field

Name

Status

Sequence

Performer

Owner

Task Type

Application Task

ORACLE

Value

Add to Pool

Active

Line Manager

Line Manager

Application Task

Add to Talent Pool

14
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Field Value

4. C(lick Save and Close.
5. Click Add Task to add the second task.
6. On the Details sub tab, specify values as indicated in this table.

Field Value

Name Add Development Goals
Status Active

Sequence 2

Performer Line Manager

Owner Line Manager

Task Type Application Task
Application Task Add Development Goal

7. Click Save and Close to return to the Tasks tab.
8. C(Click Save and Close.

Related Topics
» How You Configure Events in Checklists

FAQs

How can | diagnose any issues with Talent Review data?

Run the Talent Review Integrity Validations test if you have access to the Diagnostic Dashboard. From the Settings and
Actions menu, select Run Diagnostic Tests. The test generates a report identifying invalid rows, which you can repair or
remove.

You can validate these from the test results:

- Business groups are valid and exist.

15
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- Foreign key attributes aren't null.

- Row counts on setup tables are greater than zero.

16
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5 Talent Review Profile Options and
Descriptive Flexfields

Search Logic Profile Options for Client List of Values

You can use the logic <codeph>CONTAINS</codeph> to create the client list of values. This returns results containing
the characters you enter. Optionally, for individual list of values, you could change this logic to <codeph>STARTS
WITH</codeph>, to return results that start with the search characters you enter.

For example, when you search for a person with the name John Smith while using the logic conrains, you can search by
'jo' or 'sm' or 'th'. When you use the logic starTs wiTh, your search must start with 'j'.

Use the logic starts wite when your list contains thousands of values (more than 15,000 records) to improve the search
performance. Or, if you don't partition your data by set ID.

Note: If you change the search logic for a client list of values, the logic changes in all pages where the list of values is
used.

Related Topics
« Search Logic Profile Options for Client List of Values

« Search Logic Profile Options for Client List of Values in Global Human Resources

Talent Review Profile Options

As an application implementor, you can use Talent Review profile values to configure the Oracle Fusion Talent Review
work area in these ways:

- Specify the folder to store analyses for selecting the review population for a meeting.
Indicate if meeting facilitators can include themselves in the review population or not.
Enable responsive Oracle Fusion Talent Review pages.

- Configure how manager search works in responsive pages.

General Profile Option

This table describes the Talent Review profile value for specifying the default reports folder and lists the task that you
need to use to change the profile value.

17
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Profile Option Code Profile Display Name Default Value
HRR_DEFAULT_ Default Reports Folder None
REPORT_FOLDER for Talent Review

ORA_HRR_ALLOW_ Allow facilitator to Y

FACILITATOR_TO_
SEARCH_OWN

add themselves to the
review population

Responsive Profile Options

What Happens When Task to Use

You Change the
Profile Value

HR specialists can

Talent Review Profile

Comments

- You can copy

add analyses to the Option Values the folder
specified folder. path directly
They can then select from Oracle
an analysis to add Transactional
workers to the review Business
population of a talent Intelligence
review meeting. (OTBI) by
navigating

Meeting facilitators
can't include
themselves in the
review population
of a Talent Review
meeting.

Manage Administrator

Profile Values

to Properties

for one of the
analyses in the
folder. You can
then paste the
copied location in
the Profile Value
field.

- You can enter
only one folder
location.

«  The profile value
must start with a
forward slash (/),

but not end with
a forward slash.

If a Talent Review
meeting has more
than one facilitator,
a facilitator can add
any of the other
facilitators to the
review population.
Also, facilitators

can always include
themselves as review
participants.

Some profile options are specific to responsive Talent Review. Use the Manage Administrator Profile Values task to

change the responsive Talent Review profile options.

I Tip: Select the Talent Review application and click Search.

This table describes the Talent Review profile values that are used for responsive Talent Review pages and lists the

default value of the profile options.

Profile Option Code Profile Display Name

ORA_HRR_TALENT_REVIEW_

RESPONSIVE_ENABLED Pages Enabled

ORACLE

Mobile-Responsive Talent Review

Default Value Effect of Enabling

Y You will see the responsive Talent
Review pages.
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Profile Option Code Profile Display Name Default Value Effect of Enabling
ORA_HRR_LOV_SEARCH_ Search for Talent Review Managers Y When you search for managers
TRMANAGERS_STARTSWITH Starts with Enabled to include in a meeting on a

responsive Talent Review page,

the search results include manager
names that start with the specified
characters.

Related Topics
« How You Select the Review Population for a Talent Review Meeting

« Overview of Profile Options

Descriptive Flexfields for Talent Review

You can add descriptive flexfields to theseTalent Review entities:
« Meeting template
- Meeting configuration details

You can use descriptive flexfields to add your company-specific attributes to an entity.

Define Descriptive Flexfield Segments for Talent Review
Use the Manage Talent Review Descriptive Flexfields task to define a segment for a descriptive flexfield for Talent
Review.

This table describes two descriptive flexfields available by default in Talent Review.

Flexfield Code Name Description

HRR_DASHBOARD_TMPLS_B Dashboard Template Fields for template details that appear on the
Create Talent Review Template and Manage
Talent Review Template pages.

HRR_MEETINGS Dashboard Meetings Fields for meeting configuration details that
appear on the Create and Edit Talent Review
Meeting: Enter Meeting Details pages.

Related Topics
« Overview of Descriptive Flexfields

« Overview of Flexfields
- Considerations for Planning Descriptive Flexfields
« Considerations for Managing Descriptive Flexfields

19
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20053950
https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20052785
https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20030935
https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20030415
https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20043508
https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20030923

Talent Management Cloud Chapter 3
Implementing Talent Review and Succession Management Talent Review Profile Options and Descriptive Flexfields

20
ORACLE



Talent Management Cloud
Implementing Talent Review and Succession Management

4 Talent Review Templates

Talent Review Template

The talent review template controls these aspects of a talent review meeting:

Inclusion of succession plans and talent pools
Inclusion of matrix managers as reviewers

Maximum number of records for a meeting

Layout of the box chart that displays employee ratings
Filters that facilitators can use in a meeting

Actions that facilitators can perform

Chapter 4
Talent Review Templates

As an implementor, you create templates which facilitators can use to create talent review meetings. Facilitators can use
the same template for many meetings.

You create talent review templates on the Talent Review Templates page. You can navigate to this page in these ways:

- Use the Configure Talent Review Dashboard Options task in the Setup and Maintenance work area.

- Use the Search Talent Review Template quick action available in My Client Groups.

This image shows what you typically specify while creating a Talent Review meeting template.

ORACLE
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Chapter 4
Talent Review Templates

The maximum number of records you specify in the template is the maximum number of employees allowed for the

review population. The default value is 500.

Why You May Need Many Templates

You may need to create multiple templates for these cases:

Each organization or geographic region uses different rating models to rate employees.

- Organizations use different box-chart configurations. For example, one organization uses a nine-box

configuration and another uses a six-box configuration.

Industry or legislative rules governing diversity data, such as age and gender, vary by organization or

geographic region.

What Happens When You Include Succession Plans and Talent Pools

When you include succession plans and talent pools in a template, facilitators and reviewers can perform these actions:

- When creating a meeting based on the template, facilitators can add succession plans and talent pools that

they can access to the meeting.

ORACLE
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- When preparing review content, reviewers can add employees to plans and pools that they can access in the
participant view of the dashboard. They can also add succession plans and talent pools.

While conducting a meeting, facilitators can perform these actions:

- Add employees in the review population as candidates to plans included or created in a meeting.

- Add employees in the review population as members of talent pools included or created in a meeting.

What Happens When You Include Matrix Managers as Reviewers

The setting for inclusion of matrix managers as reviewers is carried over to new meetings that are created based on
the template. Note that this setting doesn't apply to existing meetings that were created based on the template. If you
enable the inclusion of matrix managers as reviewers in the template, and if facilitators don't change this setting in
the meeting configuration when they create a new meeting, facilitators can add matrix managers as reviewers for the
meeting. Here's what happens when facilitators include matrix managers in the meeting:

Matrix managers receive notification when the talent review meeting in which they're included is scheduled or
updated.

- They can view and rate their dotted line reports on the Prepare Review Content page if they have the relevant
profile security permissions.

- They can add notes and tasks for their dotted line reports.

- On the Talent Review meeting dashboard, they can perform the same actions as other managers included in
the meeting.

How You Decide the Submission Process Threshold

The submission process threshold is used to automatically run a scheduled process to update ratings in the employee
profiles for these actions:

Facilitator submits the meeting: The submission process threshold indicates the size of the review
population. For example, if you enter 500 as the submission process threshold, when there are 500 or more
employees in the review population, a scheduled process is automatically run to update the profile ratings
when the facilitator submits the meeting.

Manager submits the ratings after preparing review content: The submission process threshold indicates
the maximum number of employees the manager can rate. For example, if you enter 200 as the submission
process threshold, when there are 200 or more employees rated by the manager while preparing review
content, a scheduled process is automatically run to update the profile ratings when the manager submits the
ratings.

When the scheduled process starts, a message displays the job number. You can also see the job number of the process
next to the meeting status in the Talent Review Meetings overview page. You can track the process using this job
number.

What You Can Specify in the Ratings Options Section

You can configure the ratings that you plan to use to rate the review population or show as a display option in the
Ratings Options section.

1. Click Add to add a new rating.
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2. Select arating.

Its display label automatically populates. But you can change the display label.

3. If you don't want to use the rating to rate the review population, then clear the corresponding Use to Rate
Review Population check box.

Note: After adding a rating, you can’t select the same rating to add.

You can use the ratings for which the Use to Rate Review Population check box is selected to set up the box chart and
table views of the meeting dashboard created based on the template.

Note: Customizations done for the Rating Options section prior to 22A release won’t be available now. You need to
recreate the customizations again.

How You Can Set Up the Box Chart Views

You can make available different box chart views for the facilitators to use while conducting the meeting. This enables
the facilitators to rate the review population on different parameters. For example, you can create one view that allows
meeting participants to rate employees both on risk of loss and performance. You can also create a single rating view
that allows the meeting participants to rate the overall competency of the employees in the review population.

1. Specify these values for creating the box chart views:

o View name: Enter a unique name that will let the facilitator know the use of the box chart view.
o View Type: Select from the two available types.

o X-Axis or Single Rating: Select the rating that you want to use on the X-Axis of the box chart or for the
single rating view.
o Y-Axis: Select the rating that you want to use on the Y-Axis of the box chart.
2. Select one box chart view as the default.
3. Configure the boxes that appear in the box chart.

o For box charts of the XY View type, the number of rating categories in the rating models you selected
determines the box-chart dimensions. For example, one rating model combination may deliver a nine-
box configuration and another a six-box configuration. For each box, you can specify a label

o For box charts of the Single Rating View type, you select the dimensions and the rating levels to
populate each box.

Note: You need to submit at least one XY or single rating view. Select the corresponding Submit Box Assignment
check box.

What You Can Specify in the Data Options Selection

In the Data Options section, select the data and actions available to meeting facilitators and participants during a Talent
Review meeting. You typically select these values:

- The analytic options that you want to appear on the box chart matrix. Facilitators and participants can select up
to two of these values at one time during the meeting.

- The filters to be displayed on the Talent Review meeting dashboard.
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- The actions facilitators can perform while conducting the review meeting.

- The diversity-related information to be made available on the Talent Review meeting dashboard. Facilitators
and participants can highlight selected segments of the review population based on these options.

Related Topics
« Box Chart Matrix Options

- Talent Review Data Options

- How Talent Review Works with Profiles, Goals, and Performance Management
- Talent Review Life Cycle

» How Succession Plans, Talent Pools, and Talent Reviews Work Together

Box Chart Matrix Options

You can see the box chart matrix on the Talent Review meeting dashboard. Configure it in the review template by
specifying these values:

- Ratings to make available
- Box chart views

You create talent review templates on the Manage Talent Review Templates page. In the Setup and Maintenance work
area, use these values:

- Offering: Workforce Development
- Functional Area: Talent Review

- Task: Configure Talent Review Dashboard Options

Ratings

This table describes the ratings that you can include in a Talent Review template.

Ratings Description
Impact of loss Evaluate the real or perceived effects on an organization when a person leaves.
Overall Competencies Evaluate the overall competency of a person. A competency is a combination of measurable

knowledge, skills, and personal attributes that contribute to a person's performance.

Note:

If the performance document is configured to allow section ratings and to update Profiles with the
performance document rating, then the overall competencies rating is pulled from Profiles. Else,
facilitators need to update this rating while conducting the talent review meeting.

Overall Goals Evaluate the overall goal achievement of a person.
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Ratings Description
Note:

If the performance document is configured to allow section ratings, then the overall goals rating is
pulled from Profiles. Else, facilitators need to update this rating while conducting the talent review

meeting.
Performance Evaluate a person based on their work.
Potential Evaluate a person's attainable level of excellence or ability to achieve success.
Risk of loss Evaluate the likelihood of a person leaving the company.
Talent score Evaluate a person's overall value to the organization using a rating model your organization defines.

You can score workers based on factors beyond performance and potential. These might include
readiness, ability to mentor, and learning agility.

Configure Ratings

You need to set up the ratings to use in the template.

1. Specify a label for all the ratings. The label that you assign appears on the box chart matrix for the rating when
it's used as an axis in the box chart. It also appears on the table view of the box chart that displays the ratings
and additional information used in the meeting.

Select the rating model to use for all the ratings.

3. Select the ratings you want to be available for inclusion in the box chart.

N

Note: Even if you don't make the risk of loss and impact of loss ratings available for the box chart, you can
still select these ratings as analytic options in the template. As analytic options, the ratings appear on the box
chart matrix with different colors or shapes to distinguish each worker's rating.

It's a good idea to select a rating model that's also used for the rating type in other Talent Management offerings. These
are the advantages for facilitators and participants when you select a consistent rating model:

- They can view the latest worker's Profile data in the meeting.

- They can compare the meeting ratings with those from previous meetings and determine the worker's
progress.

I Note: You must set up rating models in Oracle Fusion Profile Management to make them available in Talent Review.

Box Chart Views

In the Box Chart Views section of the template, you add and configure the available views, using the ratings you
selected in the Ratings Options section.

The rating models that you selected for the ratings in a view determines the dimensions and number of boxes in the
box chart. For example, if you map a performance rating model with two rating categories to the X-axis, and a potential
rating model with three categories to the Y-axis, then the box chart contains six boxes (2 x 3).
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Note: The rating models you select for the X and Y axes of an XY view must contain rating categories. If the rating
models you select don't have rating categories, the box chart doesn't appear because the dimensions can't be

determined.

Configure Box Chart Views

You can configure multiple unique box chart views to display worker ratings. In the meeting, facilitators can update
worker ratings for the rating types you specify as views in the box chart.

1. Add views. You can add two types of views:

o XY View: Uses two separate ratings as the axes

o Single Rating View: Uses one rating as the lone measure
2. Set the default view. Facilitators can switch between views during the meeting.
3. Label the boxes that appear in the box chart:

o For ratings used in the XY view, you can enter any label.

o For the Single Rating view, select a value from the Short Description attribute along with the box chart
dimensions. You can select from one to five rows and columns, up to a maximum of 25 (5 x 5) boxes in
the box chart.

4. You can submit the box assignment for only one XY and one Single Rating view. When you select Submit Box
Assignment for a view, the labels of the boxes appear in the table view of the box chart.

Enable Background Colors

You can enable background colors for each box of a box chart view and make it easy for facilitators and participants to
distinguish levels or ratings. For example, if you have a 9-box box chart that shows potential and performance, you can

use these color shades:
Light pink: For low performance and low potential
Magenta: For high performance and low potential
- Coral: For medium performance and potential
- Orange red: For low performance and high potential

- Crimson: For high performance and potential

Note: People with color vision deficiency can't differentiate some colors.

To enable background colors:

1. In the Box Chart Views section, click the Edit icon in the Configure Boxes column for the view that you want to
enable background colors for.
2. Inthe Configure Boxes dialog box, select the color for the boxes that you want to have a colored background.

Tip: Click Show hexadecimal code to view the hexadecimal code for the colors.

3. Click OK.
If you don't select a color for any box, then the background color of the box is gray by default.
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The colors configured are applied to the boxes in the box chart of the meeting dashboard when facilitators conduct a
meeting or reviewers preview the dashboard while preparing review content. The Prior Ratings legend also shows the
colors configured.

Note: You need to configure colors for each box chart view. The colors configured for one view aren't applied to other
views.

Related Topics
- Talent Review Data Options

- Update Existing Setup Data

Talent Review Data Options

When creating a talent review meeting template, you specify the data and actions available to meeting facilitators and
participants. To create a talent review meeting template, use the Configure Talent Review Dashboard Options task in the
Setup and Maintenance work area.

Note: To restrict access to reviewers, meeting facilitators can override the configured data options on the Prepare
Review Content page when creating a meeting.

Data Options

Analytic Population : Color Code
Options Filters ACHEES Options

Let's look at each of these data options.

Analytic Options
This table lists the analytic options of the talent review meeting template and shows when these options are available.

Analytic Option Condition for Availability

Risk of loss Risk of loss rating model must exist
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Analytic Option Condition for Availability
Impact of loss Impact of loss rating model must exist
Mobility Mobility content type must exist

The profile management business process has predefined values for each of these analytic options. The selected
analytic options appear on the box chart matrix. Facilitators and reviewers can select up to two of these values at one
time during the meeting.

Population Filters

You can select the filters to be displayed on the talent review meeting dashboard. These filters include business unit,
job, and competency. Facilitators can filter the review population using these filters.

These options let you specify whom to include in the review population:
- Manager: Shows all managers in the review population hierarchy, even if they have no direct reports in the
review population.

- Reviewers and Participants: Shows all the direct and indirect reports of the reviewers and participants if
they're part of the review population.

- Subordinate Level: Shows only the subordinates of the meeting business leader.

- Management Level: Shows only people at the specified management level.

Actions

You can select the actions options shown in this table for the Actions section of the talent review dashboard.

Action Options What It Does Comments

Add Notes Facilitators can add notes about the meeting
or for any person in the review population.
Facilitators can also manage notes created
by the worker's manager during the content
preparation phase before the talent review.

Add Task Facilitators can assign tasks to meeting The tasks added appear in the Manage Notes
participants and others. and Tasks task the facilitator uses after the
meeting to follow up on assigned tasks.

Add Goal Facilitators can create goals or assign The goal management business process must
performance or development goals from the be available to create performance goals. The
goal library. career development business process must be

available to create development goals.

Enable Holding Area The Holding Area displays workers without During the meeting, participants can move
ratings at the start of the meeting. workers to this area from the box chart. If you
don't enable the Holding Area, workers without
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Action Options What It Does Comments

ratings at the start of the meeting don't appear

in the review.
Enable Compare Participants can compare a worker with other You can see the Enable Compare check box
workers or a job profile. in the Actions section of the Talent Review

Template page only if the Hide Person
Compare Flow profile option's value is N.

Enable Organization Chart Participants can view the organization chart of
the organization being reviewed.

Enable Potential Assessment Before the meeting, reviewers answer potential
assessment questions on the Prepare Review
Content page. The potential rating is calculated
automatically based on the responses.

Color Code Options

Use the color code options to let facilitators and participants to highlight selected segments of the review population.
Facilitators can view the average ratings for all workers within that option. For example, if a facilitator selects the
Location color code option while conducting the meeting, all workers in the review population are categorized by
location. Workers belonging to the same location are highlighted with the same color.

Related Topics
- Talent Review Template

» How Succession Plans, Talent Pools, and Talent Reviews Work Together

Talent Review Display Options

When creating or editing a talent review meeting template, you can specify the display options that meeting facilitators
and participants can see on the meeting dashboard for these ratings:

- Risk of loss
- Impact of loss
- Mobility

To create or edit a talent review meeting template, use the Configure Talent Review Dashboard Options task in the
Setup and Maintenance work area.

Configure Display Options

Here's how you configure the display options in the talent review meeting template:

1. From the Preferred Display Option list, select whether you want to show colors or shapes.
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2. Specify the colors or shapes to use for each analytic value.

Note: You can't select a color or shape for the No value and Secured analytic values. You can see default
colors or shapes for these analytic values.

3. Save your changes.

You can enter only the preferred display option for an analytic and not select any shapes or colors for each value. But if
you do so, the facilitators and participants may see some random shapes or colors on the dashboard. Let's assume that
you selected Colors as the preferred display option for the Risk of Loss rating but didn't specify the colors to show for
each value. The facilitator may once see a high risk of loss in red, medium in yellow, and low in green. The next time the
colors shown for the values may not be the same.

Advantages of Configuring Display Options

After you specify the display options, facilitators can view consistent shapes or colors for each analytic rating value.
For example if you selected Colors as the preferred display option for the Risk of Loss rating and then selected the red
color for the High value, then in all meetings that are created based on the template, the facilitator will always see high
Risk of Loss ratings indicated by the red color.

How You Include Matrix Managers as Reviewers

Your organization can ensure a comprehensive review of its employees by allowing matrix managers to rate the
performance of their dotted line reports. Matrix managers are additional managers who aren't defined as the
employee's line manager. Matrix management can be enabled on these two Talent Review pages:

Meeting templates

Meeting configuration pages

Meeting Template

If your organization usually includes matrix managers in your Talent Review meetings, as administrators you can enable
inclusion of matrix managers in the Talent Review template.

1. Inthe Setup and Maintenance work area, search for and select the Configure Talent Review Dashboard
Options task.

2. Create or edit an existing template.
3. Select the Include matrix managers as reviewers check box.
4. Save your changes.

Meeting Configuration Pages

Even if your administrators haven't enabled adding matrix managers as reviewers, as facilitators you can enable this
when you create a Talent Review meeting.

1. Create a talent review meeting.
2. Inthe Review Participants section, select the Include matrix managers as reviewers check box.
3. Submit your meeting configuration after you have configured the meeting.
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Note that the setting in the Talent Review meeting configuration determines the inclusion or exclusion of matrix
managers. If you clear the Include matrix managers as reviewers check box in the meeting configuration, matrix
managers can't review their dotted line reports even if matrix management is enabled in the template.

FAQs

Can | edit a talent review template after it has been used for a
meeting?

Yes. On the Manage Talent Review Templates page, you can edit attributes including axis labels, default view, box labels,
color scheme, and data options. You can't edit the template name, owner, status, or selected rating models.

Changes take effect when you next open the meeting.

What happens if | don't select a preferred display option for the
ratings or specify the color or shape to use for a rating level?

The facilitators and participants will see random colors or shapes on the meeting dashboard for the analytic values. For
example, a facilitator may see a high Risk of Loss in red once and may see the same rating value in green the next time.

Can | specify the same preferred display option for more than one
analytic?

Yes. But note that on the Talent Review meeting dashboard, only the preference for the first selected analytic option

is honored. Let's assume that you selected Colors as the preferred display option for both Risk of Loss and Impact of
Loss analytics in the template. When conducting the meeting, the facilitator first selects the Risk of Loss display option
on the dashboard. The facilitator can see only the color preferences that you selected for the Risk of Loss analytic. The
colors specified for the Impact of Loss analytic is ignored.
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5 Potential Assessment

How You Set Up Potential Assessment

The potential assessment is a questionnaire that reviewers of a talent review meeting can use to rate the potential of
workers.

Administrators need to create and configure potential assessments before reviewers can use them to prepare review
content. This image shows how to set up a potential assessment to rate the review population of a talent review
meeting.

Configure Rating
Models

l

Create Potential
Assessment

l

Enable Potential
Assessment in
Template

Configure Rating Models
An administrator needs to configure the Potential and Potential Assessment rating models to add or change rating
levels or review points. As an administrator, you manage rating models on the Profile Rating Models page. In the Setup
and Maintenance work area, use these values:
- Offering: Workforce Development
Functional Area: Talent Review

- Task: Configure Talent Review Dashboard Options

Create Potential Assessment

An administrator needs to create a potential assessment before it's available to use in meetings.

1. Use the Potential Assessment task available in the Setup and Maintenance work area.
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2. Locate the predefined potential assessment questionnaire named Potential Rating that's available in the
Potential Rating folder.

3. Select if you want to create a new version of the questionnaire or update the existing questionnaire.

4. Add questions to the questionnaire.

5. Associate responses in the Potential Rating Model with the questions added.

Enable Potential Assessment

As an administrator, on the talent review template, you need to enable reviewers to access potential assessment:

1. Use the Configure Talent Review Dashboard Options task available in the Setup and Maintenance work area.
2. Create a new template or edit an existing template.
3. Select the Enable Potential Assessment check box in the Data Options section of the template.

Related Topics
* Questionnaires

- Rating Models
» Update Existing Setup Data

Guidelines for Configuring a Potential Assessment

If you want to allow your reviewers to use the potential assessment feature to rate workers, you need to first configure a
Potential Assessment questionnaire. Use the Potential Assessment task in the Setup and Maintenance work area to do
this. The Potential Assessment questionnaires are available in the Potential Rating folder.

To configure a Potential Assessment questionnaire:

1. In the Potential Rating folder, edit the Potential Rating questionnaire.
2. Select one of these options and click OK.

o Create a New Version of the Questionnaire
o Update Existing Questionnaire

3. Edit the basic information:

o Name of the questionnaire
o Status
o Inthe Instructions and Help Materials section, enter any instructions for questionnaire users. This text
appears on the first page of the questionnaire.
4. Add sections if you want to.
5. Add or create questions in each section and select response type.
6. Review and save the questionnaire.

Sections

You need to have at least one section for a Potential Assessment questionnaire. You use different sections to group
questions by question type or other criteria. For each section, you can enter specific instructions.

34
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20033891
https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20028971
https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20051179

Talent Management Cloud Chapter 5
Implementing Talent Review and Succession Management Potential Assessment

You can select these options for a section:
- Required: To ensure that respondents answer all questions in the section.
- New Page: To start the section on a new page.

You can also control the order of questions and responses in the section.

Questions and Responses

In each section, you can add questions in these ways:

- Create new questions.

- Add questions from the Potential Assessment question library.

Note: You can't add questions from the question library used for other questionnaires.

For each question that you create, you need to specify these values:

- Question text

- Response type: Single choice from a list or a radio button

Available Responses

The responses are determined by the rating levels in the Potential Assessment rating model:

- The number of rating levels is the same as the number of potential responses.
- The text of the response is the short description value for the rating level.

- The value of each response is the numeric rating of the rating level.

Number of Questions

The number of questions you add is determined by these parameters:
- Number of rating levels and numeric rating for each in the Potential Assessment rating model
- Rating level and corresponding range of review points for each rating level in the Potential Rating Model

To get a valid potential rating, add enough questions so the total of the numeric value of the responses maps to an
appropriate level in the review points. The maximum total value for each rating level should fall between the review
point range for the level.

Number of Questions Examples

Consider the rating model configuration shown in this table.

Potential Assessment Potential Assessment Potential Rating Potential Rating Potential Rating Final Potential Rating
Rating Model Rating Rating Model Model Rating Level Model Review Points Model Review Points
Level Numeric Rating Range For Each Level
1 1 1 1 0-13 1-Low
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Potential Assessment Potential Assessment Potential Rating Potential Rating Potential Rating Final Potential Rating
Rating Model Rating  Rating Model Model Rating Level Model Review Points Model Review Points
Level Numeric Rating Range For Each Level
2 2 2 2 14-21 2-Medium
3 3 3 3 22-99 3-High

The number of questions must ensure that the review points from the Potential Assessment rating model map to the
review points range in the Potential rating model.

Let's assume that there are 7 questions. Here's the total points for each rating level in the Potential Assessment rating
model.

- Rating Level 1: 7 * 1=7 points
- Rating Level 2: 7 * 2 =14 points
- Rating Level 3: 7 * 3 = 21 points
You can see that for Rating Level 3, the total points is less than the review points range of the Potential rating model.

Now, let's assume that there are 8 questions. Here's the total points for each rating level in the Potential Assessment
rating model.

- Rating Level 1: 8 * 1 = 8 points

- Rating Level 2: 8 * 2 =16 points

- Rating Level 3: 8 * 3 = 24 points

All these scores from the Potential Assessment rating model map correctly to the review points range in the Potential
rating model. This shows that you need to create 8 questions to rate potential.

Now, consider the rating model configuration shown in this table. The review points range is changed here.

Potential Assessment Potential Assessment Potential Rating Potential Rating Potential Rating Final Potential Rating
Rating Model Rating  Rating Model Model Rating Level Model Review Points Model Review Points

Level Numeric Rating Range For Each Level

1 1 1 1 0-7 1-Low

2 2 2 2 8-12 2-Medium

3 3 3 3 13-99 3-High

For this review point range, you need to create 5 questions to rate potential.

36
ORACLE



Talent Management Cloud Chapter 5
Implementing Talent Review and Succession Management Potential Assessment

Related Topics
« Example of Rating Potential Using the Potential Assessment

« How You Set Up Potential Assessment
« Configure a Potential Assessment

Example of Rating Potential Using the Potential
Assessment

The potential assessment is a questionnaire that calculates potential rating for a worker based on the responses
reviewers provide before a talent review meeting. The potential assessment calculates the total number of points
for each response based on the Potential Assessment rating model. The Potential Assessment maps the total to the
Potential Rating Model to determine the potential rating.

Talent review reviewers use the potential assessment on the Prepare Review Content page. Select My Client
Groups > Talent Review . You create the potential assessment on the Manage Questionnaires page. In the Setup and
Maintenance work area, use the following:

- Offering: Workforce Development
Functional Area: Talent Review
- Task: Manage Potential Assessment

Settings That Affect Potential Assessment

There are three configurations that affect the ranking score:

Number of rating levels, and the numeric rating assigned to each level, in the Potential Assessment rating
model

Number of rating levels, and review points and points range assigned to each level in the Potential Rating
Model

Number of questions in the Potential Rating (potential assessment) questionnaire

How Potential Rating Is Calculated

The potential assessment contains a set of questions with responses associated with the Potential Assessment rating
model. Each possible response represents one unique rating level in the Potential Assessment rating model. The value
of each response is the same as the numeric rating for the rating level.

Each rating level in the Potential Rating Model is associated with a range of review points.

When the reviewer completes the potential assessment:

1. The total value of the selected responses is calculated by adding the numeric rating for the rating levels in
Potential Assessment rating model.

2. The calculated total is compared to the range of review points in the Potential Rating Model to determine the
rating level.

3. The final potential rating is the rating level that corresponds to the sum of the review points in the Potential
Rating Model that fit in the range between the From Points and To Points.

37
ORACLE



Talent Management Cloud Chapter 5
Implementing Talent Review and Succession Management Potential Assessment

Example

In this example:

- The Potential Rating questionnaire contains eight questions.
- The Potential Assessment rating model contains three rating levels, one for each possible response to the
questions. Each rating level has a numeric rating. The responses and their numeric ratings are:
o Strongly Agree: 3
o Agree:2
o Disagree: 1
- The Potential Rating Model has three rating levels. The table shows the numeric ratings for each rating level

in the Potential Rating Model, the short description that describes the rating level, the review points, and the
points range for each level.

Note: You must configure all the Potential Rating Model attributes shown in the table to use the potential
assessment.

Numeric Rating for Rating Short Description Review Points Points Range: From Points Points Range: To Points
Level

1 Low 1 0 13

2 Medium 2 14 20

3 High 3 21 99

Reviewers must answer each question to ensure that the potential assessment is valid. Because the lowest possible
rating value for each question is 1, the minimum score is 8. The maximum score is 24. If the sum of the reviewer's
selections is 16, that corresponds to the points range of 14-20, and the review points level is 2. The associated numeric
rating for the rating level is 2 for that review points level. Therefore, the final potential rating is 2-Medium.

Related Topics
 Accessing Tasks to Update Existing Setup Data: Procedure

Configure a Potential Assessment

This example demonstrates how to configure a potential assessment questionnaire that talent reviewers can use to rate
worker potential before a talent review meeting.

The following table summarizes key decisions for this scenario.
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Decisions to Consider In This Example
How many sections? One
How many questions should | create for Eight

the questionnaire?

Summary of the Tasks

Configure the Potential Assessment questionnaire.

1. Enter questionnaire basic information.
2. Enter questionnaire contents.
3. Create questions.

Prerequisites

Chapter 5
Potential Assessment

1. Configure the Potential Assessment rating model using the attributes shown in the following table.

Rating Level Name and Short Description
DISAGREE Disagree

AGREE Agree

STRONGLY_AGREE Strongly Agree

Numeric Rating

2. Configure the Potential rating model using the attributes shown in the table.

Rating Level Name and Short Review Points
Description

LOW Low 1

MEDIUM Medium 2

HIGH High 3

Entering Questionnaire Basic Information

Review Points From
Points

14

21

Review Points To Points

13

20

99

1. Inthe Set Up and Maintenance work area, click Manage Potential Assessment to open the Manage

Questionnaires page.

ORACLE
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2. Inthe Search Results section, select Potential Rating and click Edit to open the Edit Questionnaire: Potential
Rating dialog box.

3. Leave Update Existing Questionnaire selected and click OK to open the Edit Questionnaire Basic Information
page.

4. On the Edit Questionnaire Basic Information page, complete the fields, as shown in this table.

Field Value

Name Potential Rating
Status Active
Introduction Any

5. Click Next to open the Edit Questionnaire Contents page.

Entering Questionnaire Contents

1. On the Edit Questionnaire Contents page, complete the fields, as shown in this table.

Field Value
Section Order Sequential
Section Presentation No Sections
Page Layout 1 Column

Maximum Number of Questions per ~ Blank
Page

2. Inthe Sections section, click Create to open the Create Section dialog box.
3. Complete the fields, as shown in this table. Use the default values unless otherwise indicated.

Field Value
Name Section 1
Description Any
Question Order Vertical
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4. Click OK to return to the Edit Questionnaire Contents page.
5. Inthe Sections section, in the Section 1 row, complete the fields, as shown in this table.

Field Value
Question Order Vertical
Response Order Vertical

Creating Questions

In the Sections section, select Section 1.

In the Section 1: Questions section, click Create to open the Add Questions dialog box.

In the Questions section, in the Question field, enter This person is a long-term thinker.

In the Response section, in the Presentation field, select Radio Button List.

Click Preview to open the Preview dialog box.

Click OK to return to the Add Questions dialog box.

Click Save to return to the Edit Questionnaire Contents page.

Repeat steps 2 through 7 to create seven additional questions, using the questions and presentation type
shown in the table.

OO UhWUNRA

Question Text Presentation
This person has the ability to lead Radio Button List
others through influence, and not just

authority

This person is a creative problem solver Radio Button List

This person thrives on new challenges = Radio Button List
and delivers results

This person is a good fit within our Radio Button List
culture

This person has an effective network; Radio Button List
both internally and externally

This person is self-aware, and strives Radio Button List
for both personal and professional
development

A1
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Question Text Presentation

This person recognizes and leverages Radio Button List
the potential in others

9. Click Next to open the Edit Questionnaire Review page.

10. Click the Preview button to open the Preview Potential Rating dialog box.

11. Click OK to return to the Edit Questionnaire Review page.
12. Click Save and Close.

Related Topics
 Potential Assessment: Explained

- Configuring a Potential Assessment: Points to Consider
- Rating Potential Using the Potential Assessment: How It Is Calculated

ORACLE
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6 Talent Review Tasks and Notes

Talent Review Tasks

As a facilitator, reviewer, or a Talent Review super user, you can create, assign, and manage tasks for action items arising
from a talent review.

Manage talent review meetings and the associated tasks from the Talent Review work area.

- Facilitators and Talent Review super users need to select My Client Groups > Talent Review .

- Reviewers need to select My Team > Talent Review .

Create and Assign Tasks

You can create and assign tasks in these areas:

- Talent Review dashboard: Select any person in the review population and add a task. The person to whom you
add the task is automatically the Associated Worker, and the person's manager is the Assignee. But you can
change this.

- Tasks page: Assign a task to any person you have access to; you aren't restricted to assigning tasks to meeting
participants or the review population

In addition to a subject and description, you define the task attributes shown in this table.

Task Detail Description

Associated Worker The person for whom the task is added.

Assignees One or more workers who perform the task.
Note:

The person's manager is the default assignee.

Owners People who manage the task. The meeting facilitator or Talent Review super user is the task owner by
default, but you can add more owners. Owners need not be meeting facilitators, but if the task owners
can't access the Tasks page, they may not be able to manage the task.

Task Type The category of the task, such as Preparation and Presentation. Task type values exist in the HRT_
TASK_TYPE lookup. You can add values to suit your business requirements.

Due Date Date by when assignees need to complete the task. The default date is one year from the current date.

Priority Level of urgency for the task, such as High, Medium, or Low. Priority values exist in the HRT_TASK_
PRIORITY lookup. You can add values to suit your business requirements.
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Task Detail Description
Percentage Complete The completion percentage of the task. Owners update the field as the assignee progresses on the
task.
Status Assigned or Completed.
Start Date Date when work begins for the task.
End Date Date when the task is complete.
Edit Tasks

You can edit tasks only on the Tasks page and not on the Talent Review meeting dashboard. You can edit any task field,
and reassign and delete tasks. If a task has multiple owners or assignees, then all can view any changes made by one of
them.

View Task History

You can view all tasks for all current and past meetings for an associated worker on the Tasks page.

1. Inthe Tasks section, select the associated worker row.
2. From the Actions menu, select View History.

Related Topics
 Profile Management Lookups

Overview of Alerts for Talent Review Tasks

Facilitators or reviewers can assign tasks to managers and HR specialists when conducting or preparing a Talent Review
meeting. Task assignees can complete their tasks on time if they receive these notifications:

- Notifications for tasks assigned to them or that they now own
- Notifications for tasks that are due

Alerts for Talent Review Tasks

As an administrator, use the Talent Review Tasks Alert template in Alerts Composer to configure notifications related
to Talent Review tasks. It includes these alert templates:

- Notification for New Task Owner: Enable to send a notification to task owners for each task of a Talent Review
meeting that they're added as an owner.

- Notification for New Task Assignee: Enable to send task assignees a notification for each task of a Talent
Review meeting that they're assigned.

- Notification of Aggregated Tasks for Owner: Enable to send a notification to new owners about all tasks of a
Talent Review meeting in which they have been added as an owner in the specified number of days.
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- Notification of Aggregated Tasks for Assignee: Enable to send a notification to new assignees of all tasks of a
Talent Review meeting that they have been assigned in the specified number of days.

- Reminder Notification for Task Due: Enable to send a notification to assignees that a task is due in the
specified number of days.

Note: All these alerts are disabled by default.

Related Topics
« Alerts Composer

Notify Owners and Assignees about Talent Review
Meeting Tasks

As an administrator, you can configure alerts to send individual or aggregate notifications to managers and HR
specialists when they're assigned a new task for a Talent Review meeting or made the task owner.

Note that for existing tasks, when an HR specialist or a reviewer adds a person as an owner or an assignee, notifications
are sent only if the task isn't complete. Also remember that if an employee is both an owner and an assignee for a task,
the employee gets 2 notifications.

Send Individual Task Notifications to New Task Owners and Assignees

Your organization may want to notify employees every time the employee is assigned a task or made an owner. Here's
how you configure this:

1. Search for and open the Talent Review Tasks Alert template in Alerts Composer.
2. Ensure that it's enabled.
3. Enable these alert templates:

o Notification for New Task Owner

o Notification for New Task Assignee
4. Click Save and Close.

Send Aggregated Notification of Tasks to Owners and Assignees

Your organization may not want to send a notification to employees every time they're added as an owner or assignee
to a task associated with a Talent Review meeting. In this case, do these steps:

1. Configure alerts to send an aggregated notification of tasks for a meeting.
2. Run the Send Notification for Talent Review Tasks process.

Note: To run the Send Notification for Talent Review Tasks process, you need to have the Run Global HR
Processes (PER_RUN_HR_PROCESSES_PRIV) function security privilege.

To configure alerts to send an aggregated notification of tasks for a meeting, do these steps:

1. Goto Tools > Alerts Composer .
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2. Search for and select the Talent Review Tasks Alert template.
3. Ensure that it's enabled.
4. To send an aggregate notification to task owners:

a. Disable the Notification for New Task Owner template.
b. Enable the Notification of Aggregated Tasks for Owner template.
5. To send an aggregate notification to task assignees:

a. Disable the Notification for New Task Assignee template.
b. Enable the Notification of Aggregated Tasks for Assignee template.
6. Click Save and Close.

After you configure the alerts template, you need to run the Send Notification for Talent Review Tasks process
regularly to let employees know about all tasks that they're assigned or own for a Talent Review meeting.

Go to Tools > Scheduled Processes .

Search for and run the Send Notification for Talent Review Tasks process.

Specify the number of days in the past that the process needs to check for new task assignees or owners.
Schedule the process according to your organization's needs.

5. Submit the process.

P WN

When the process completes, you can check these details in the log file:

Person identifier of the employees who were notified and their role for the task
Meeting with which the task is associated

Number of notifications sent

Note that if employees are made an owner or an assignee for tasks of more than one meeting in the specified days, they
receive separate notifications for each meeting.

Related Topics
« Alerts Composer

« Submit Scheduled Processes and Process Sets

Remind Assignees When Talent Review Tasks Are Due

Your organization may want to send a reminder to task assignees before the tasks are due. This helps the assignees to
prioritize work and complete tasks. To send task reminders, as administrators, you need to do these steps:

1. Configure the Talent Review Tasks Alert template.
2. Run the Send Reminder for Talent Review Tasks That Are Due process.

Note: You can run this process only if you have the Run Global HR Processes
(PER_LRUN_HR_PROCESSES_PRIV) function security privilege.

Remember that task owners aren't notified about tasks that are due.
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Configure Alerts to Send Task Reminders to Task Assignees

Do these steps to configure alerts to send reminders to task assignees:

Go to Tools > Alerts Composer .

Search for and select the Talent Review Tasks Alert template.

Ensure that it's enabled.

Ensure that the Reminder Notification for Task Due template is enabled.
Click Save and Close.

R UWUNA

Run the Send Reminder for Talent Review Tasks That Are Due Process

After you configure the alerts template, you need to run the Send Reminder for Talent Review Tasks That Are Due
process regularly to let task assignees know about tasks that they need to complete for a Talent Review meeting.

Go to Tools > Scheduled Processes .

Search for and run the Send Reminder for Talent Review Tasks That Are Due process.
Specify the number of days before the task due date that the process needs to check for.
Schedule the process according to your organization's needs.

5. Submit the process.

P UWN

When the process completes, you can check these details in the log file:

Person identifier of the employees who were notified
- Task due date

Meeting with which the task is associated
- Task title

- Number of notifications sent

Related Topics
« Alerts Composer

« Submit Scheduled Processes and Process Sets

Talent Review Notes

You can create notes for workers in the review population of talent review meetings. You can also create notes about the
meeting.

Facilitators need to select My Client Groups > Talent Review .
Reviewers need to select My Team > Talent Review .

To manage notes, select the View Notes option from the Actions menu of a meeting.

Notes use the Feedback feature that's available in person spotlight and person smart navigation. When you view the
feedback for a person, you can identify the notes that were created in a talent review meeting by the name of the
meeting that's displayed in the note.
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Create Notes

You can create notes for both the meeting and the workers in the review population.

- On the meeting dashboard, select a worker in the review population and click Add Notes.

- On the Notes page that opens when you select the View Notes option from the Actions menu of a meeting,
you can add notes in these ways:

o To add a note about the meeting, in the Meeting Notes section, click Add.

o To add a note for a worker:

i. Click the Notes link in the worker row.
ii. Inthe Notes section, click Add.

- On the Prepare Review Content page, to add a note for a worker in the review population, do this:

a. Select the worker row.

b. From the Actions menu, select View Notes.
c. Inthe Notes section, click Add.

When you create a note, you need to specify who can see the note. The visibility settings that you see depend on what
your administrator has configured for Talent Review using the Feedback Visibility task. This table shows the options that
are generally available to indicate the note visibility in Talent Review.

Note: Meeting facilitators can see the notes created for a Talent Review meeting only when they open the meeting.
When they're in the meeting, they can see any meeting note added for all workers in the review population even

if they don't have data access to all workers. But they can't see the meeting note on the Feedback page in person
spotlight if they don't have access to the worker.

Visibility Setting

Everyone

Managers Only

Managers and <Worker Name>

Only Me

Only worker and me

ORACLE

Who Can See the Note

Any person in the organization. People who aren't participants in the meeting can view the note in the
person spotlight page.

Managers in the hierarchy of the worker for whom the note is created and the meeting facilitators.

Managers in the hierarchy of the worker, the meeting facilitators, and the worker for whom the note is
created. The worker can view the note in the person spotlight.

Only the author of the note. However, if the facilitator creates the note on the dashboard during the
actual meeting, the participants can see it when the meeting is conducted.

Only the author of the note and the worker for whom the note is created.
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View History
Facilitators can view all notes for all meetings for the members of the review population, including those created by
reviewers.

1. Select the View Notes option from the Actions menu of a meeting.
2. Click the Notes link in the worker row.
3. Select a meeting to view the notes created for that meeting.

Create Reports

You can create reports for notes using Oracle Transaction Business Intelligence (OTBI).
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7 Succession Management

Succession Management

You can use succession management to create succession plans for replacing key employees.
These are the advantages of using succession plans:

- Ensure a smooth transition to key jobs and positions.

- Identify workers who are ready now, or who can become ready by developing the necessary skills, for jobs and
positions that are likely to become vacant.

- Plan the career development of candidates.

You manage succession plans in the Succession Plans work area. Select My Client Groups > Succession Plans .

Plan Types

Select from these succession plan types:

- Incumbent: Use this plan type to replace a specific person.
- Job: Use this plan type to identify candidates for a job, such as Business Analyst or Sales Representative.

- Position: Use this plan type to identify candidates for a position, such as Senior Vice President for Sales or
Assistant Marketing Manager.

Plan Access

To access the Succession Plans work area, you need to have the Succession Plan Management duty role. To create a
succession plan, you need to have the Create Succession Plan for Worker duty role. The HR specialist job role has these
duty roles by default.

Managers can use these options to create succession plans:

- Create Succession Plan action for a direct or indirect report in My Team > Career Overview
- Add button in the Succession Plans section of Succession Planning tab on person spotlight

- Create Succession Plan Quick Action available in My Team
A succession plan can be a private plan. Only the named owners can access private succession plans.

Only these users can manage a nonprivate succession plan:

- A plan owner. Whoever creates or edits the plan can select the plan owners. Remember to specify at least one
owner for a private succession plan.

- A person who has access to the named or inferred incumbent of the plan. Any person who holds the job or
position for which the succession plan is created is an inferred incumbent.

- A super user. An administrator can create a custom super user role and assign this role to any user. It's a good
idea to make at least one person in your organization a super user.
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Plan Incumbents

You can view the incumbents who currently have the same job or position as defined in Job and Position type
succession plans. The succession plan attributes such as business unit and department if specified determine the
incumbents who have the same position or job. You can see the incumbent information on these pages:

+ Succession Overview
- Succession Planning tab of person spotlight

- Incumbents section of the succession plan

I Note: You can see only the incumbents that you have access to.

Plan Candidates

Succession plans can have multiple owners from different organizations. So you can include candidates from multiple
organizations in succession plans.

You can add candidates to a succession plan in these ways:
- Search for employees that you can access and add them as candidates.

- Add external candidates.

- Use Best-Fit feature to find candidates who match the job or position requirements.

Note: The Best-Fit feature isn't available on mobile devices.

- Add talent pool members.

You can see these details for each candidate in the Candidates section of a succession plan:

- Date when they were added as a candidate to the plan
- Readiness information
- Status

You can also see the current job title for internal candidates.

You can view these counts for candidates who are also a candidate in other succession plans:

- The total number of plans in which the person is a candidate

- The number of plans that you can access in which the person is a candidate
Click the count link to view the corresponding list of other succession plans in which the person is a candidate.

By default, you can see only the count for the number of plans that you can access. You can't see the count that shows
the total number of plans the person is a candidate on. Your administrator can however use Transaction Design Studio
to show this count.

Note: You can identify the external candidates in a succession plan.
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To find more information about an internal candidate, click the candidate name. The Succession Planning tab in person
spotlight for that candidate opens where you can see these details:

- The succession plans created for that person that you can access
- The succession plans in which the person is a candidate that you can access
- The talent pools in which the person is a member and which you can access

- Risk of Loss, Impact of Loss, and Job Criticality details

Here's how you can add internal candidates to a succession plan when you aren't in the Succession Plans work area:

- Navigate to My Team or My Client Groups. Use the Add to Succession Plan Quick Action. Select a person and
add them to a selected succession plan.

- Navigate to My Team > Career Overview . Use the Add to Succession Plan action for the person who you
want to add as a candidate.

- Select a person from the review population of a Talent Review meeting and add them as a candidate to any
succession plan associated with the meeting.

You can create or edit external candidates in the External Candidates section of the Succession Overview page. When
creating an external candidate, you need to specify the last name. The other fields such as first name, job title, e-mail,
and phone are optional.

Note: You can select only these succession plans when you try to add candidates:
- Plans for which you're a named owner

- Plans in which you have access to the named or inferred incumbent of the plan

Candidate Attributes

You can use these attributes to specify which of your candidates on a succession plan are most capable of filling a
vacant job:

- Readiness: This indicates how soon a person can take up the job or position. You select a readiness level based
on these factors:

o Your knowledge of the candidate

o How well the candidate's current competencies match the skills of the job or position associated with the
plan

- Candidate Ranking: This indicates the order of preference for a succession plan candidate to fill the job
associated with the plan when it becomes vacant. You can rank candidates across the entire plan, or you can
rank candidates within a readiness category. You can have multiple candidates with the same ranking across
readiness categories.

- Interim Successor: This indicates that the candidate can't be considered as an actual prospect but can perform
the duties of the incumbent, or for the job or position, until an actual successor is identified.

By seeing the readiness levels of all candidates in a plan, you can determine the bench strength for the job or position
and your organization. For example, if no candidate is likely to be ready in the next 2 years, the bench strength is poor.
You can add other candidates in this case.
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Talent Pools

You can add candidates in a succession plan to an existing talent pool to manage candidate development. The
development goals in a talent pool can prepare candidates for the relevant job or position.

Related Topics
« Examples of Creating Succession Plans

- How Managers Can Work With Succession Plans
« Examples of Access to Nonprivate Succession Plans
- Best-Fit Analysis

How Inferred Incumbents of Succession Plans Determine
Plan Access

Any person who holds the job or position for which the succession plan is created is an inferred incumbent.
In the automatic plan access method, only the following users can access nonprivate succession plans:
- The named owners of the plan
Employees who have access to the named or inferred plan incumbents

To determine plan access, the inferred incumbent information for Job and Position type succession plans is stored in
the succession plan incumbent table. This table is automatically updated whenever a new succession plan is created or
when a succession plan is modified. The Succession Plan Incumbents process also updates this table when scheduled.

Attributes Considered to Determine Plan Incumbents

You can refine your succession planning by specifying additional attributes. These attributes are taken into
consideration to determine the plan incumbents to include in the succession plan incumbent table. This table indicates
the attributes that are considered to determine the incumbents for Job and Position type succession plans.

Plan Type Attributes Considered
Job Business Unit, Job Department, and Job Grade
Position Business Unit, Department

So, if you specify the job department as Sales for the Director job of a Job type succession plan, only suitable
employees from the Sales department are included as incumbents in the succession plan incumbent table. Employees
from other departments won't be included as plan incumbents.

Succession Plan Incumbents Process

Employee movement, such as changes in job roles or transfers, can also affect plan access. For example, if an employee
is transferred to another department and reports to a new manager, the former manager's access to the plans in which
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the employee is a named or an inferred incumbent should be revoked. Instead, the current manager should now be
given access to the plans in which the employee is a named or an inferred incumbent. To update the succession plan
incumbent table for these changes, a user with an implementor or administrator role should schedule the Succession
Plan Incumbents process.

You can schedule the Succession Plan Incumbents process daily, weekly, and so on, based on the frequency of changes
to your organizational structure. For example, if new employees are only inducted monthly and if your organization's
attrition rate isn't high, you can schedule the Succession Plan Incumbents process on a monthly basis.

To run the Succession Plan Incumbents process:

1. On the Scheduled Processes Overview page, click Schedule New Process.

2. Inthe Schedule New Process dialog box, from the Name list, select the Succession Plan Incumbents process,
and click OK.

3. Optionally, in the Process Details dialog box, change the process schedule to one that's appropriate for your
organization and define notifications.

Note: By default, the Succession Plan Incumbents process is scheduled as soon as possible.

4. Inthe Process Details dialog box, click Submit.

Related Topics
« Overview of Scheduled Processes

« Submit Scheduled Processes and Process Sets

Succession Management Lookups

This topic identifies common lookups for the Succession Management functional area. You can update the lookup that
has an extensible configuration level as appropriate to suit your enterprise requirements. You manage the succession
management lookups by using the Manage Succession Management Lookups task in the Setup and Maintenance
work area.

Succession Management Lookups

The following table describes the succession management lookups.

Lookup Type Description Configuration Level

HRM_READINESS_CATEGORY The estimated time before a candidate is ready = Extensible
to move into a job or position, such as ready
now, ready in 1-2 years, and ready in 3-4 years.
You must add lookups or you're limited to the
seeded values Ready now and No readiness
available.

HRM_SUCC_CAND_STATUS The status of the succession plan candidate: System

Active: The employee is an active
candidate for the plan.
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Lookup Type

HRM_SUCC_PLAN_STATUS

HRM_SUCC_PLAN_TYPE

Description Configuration Level

Inactive: The employee is no longer
considered a plan candidate.

The status of the succession plan: System

Active: The succession plan is still needed
and is valid.

Inactive: The succession plan is no longer
needed.

The type of the succession plan: System

.

Incumbent: The succession plan is
created to replace a specific employee.

Job: The succession plan is created for a
particular job role, for example, Systems
Analyst.

Position: The succession plan is created
for a particular position, for example,
Executive Vice President-Sales.

Descriptive Flexfields for Succession Management

Chapter 7

Succession Management

To add company-defined attributes, for example additional information about succession plans or candidates, use
descriptive flexfields for an Oracle Fusion Succession Management entity. You can use descriptive flexfields to define

validation and display properties.

Defining Descriptive Flexfield Segments

Use the Manage Descriptive Flexfields task to define a segment for a descriptive flexfield for the succession

management business process. You can add more information related to these succession management entities, such
as the succession plan details and candidates.

Two descriptive flexfields are available in the succession management business process.

Descriptive Flexfield

HRM_PLANS

HRM_PLAN_CANDIDATES

ORACLE

Description

Create Succession Plan: Enter Details page

Succession Plans tab in the Succession Planning work area, in the Details section

Fields for succession plan details that you enter appear in the Additional Information section in these
locations:

Fields for candidate details that appear on the Create Succession Plan: Select Candidates page in the
Additional Information column.
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Related Topics
« Overview of Descriptive Flexfields

« Overview of Flexfields

FAQs

What happens if | remove a readiness category lookup?

If the level is in use for succession plan candidates or talent pool members, their readiness level changes to No
readiness available. Plan or pool owners can select a different readiness level for affected workers.

How can | set a default plan type or control the order of plan types
in the succession plan type list?

To control the display order of the Plan Type list of values, modify the values in the Display Sequence column of the
HRM_SUCC_PLAN_TYPE lookup codes. Search for the HRM_SUCC_PLAN_TYPE lookup in the Manage Succession
Management Lookups page. In the Plan Type list of values, the options are arranged in ascending order of their Display
Sequence value. Set the Display Sequence value of the default Plan Type option to 1. For example, if you often create
succession plans of Position type, you can set its Display Sequence value to 1.

Tip: If you use only one plan type, set its Display Sequence value to 1. Then use Oracle Page Composer to configure
the Plan Type field as a read-only field.

How can | show incumbents for existing Job and Position type
succession plans?

You need to run the Succession Plan Incumbents process at least once to show incumbents for existing Job and
Position type succession plans.

How can | hide the Incumbents section and the incumbents listed
on the Succession Overview page?

As administrators use Transaction Design Studio to hide the Incumbents section and the incumbents listed on the
Succession Overview page.

1. Enable a sandbox and then edit your pages at the Site level.
2. Open HCM Experience Design Studio.
3. Select the Transaction Design Studio tab.
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From the Action list, select Succession Plans.

Add a rule.

Enter the basic details.

From the Data Source list in the Available Attributes section, select Plan Info.
Set the value of the Incumbents attribute to Not visible.

Click Save and Close.

0V uv kA

How can | hide the option to add talent pool members as
succession plan candidates?

The option to add talent pool members as succession plan candidates is available by default. But as an administrator,
you can hide this using Transaction Design Studio.

Enable a sandbox and then edit your pages at the Site level.

Open HCM Experience Design Studio.

Select the Transaction Design Studio tab.

From the Action list, select Succession Plans.

Add a rule.

Enter the basic details.

From the Data Source list in the Available Attributes section, select Plan Info.
Set the value of the Add Talent Pool Members attribute to Not visible.

Click Save and Close.

VPRI AUWNA

Succession Management Alerts

How You Configure Alerts for Succession Plans

As an administrator, you may want to alert plan owners about assignment changes of candidates or incumbents of a
succession plan. These alerts can help plan owners decide if they need to update the succession plans. For example, if
a candidate moves to a role that's different from the plan role, the plan owner can remove that candidate and add other
candidates to the succession plan after receiving the alert notification.

Succession Plan Alerts Templates

Use the Succession Plan Assignment Change Alert templates in Alerts Composer to configure alerts for succession
plans. You can configure alerts for these assignment changes:

- A candidate's job changes to the job specified in the succession plan.

- A candidate moves to a job that's different from the job specified in the succession plan.

- The plan incumbent moves to a different role.

- A candidate moves to a position that's different from the position specified in the succession plan.

- A candidate's position changes to the position specified in the succession plan.
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- A candidate moves to a role different from the plan incumbent's role.

- A candidate moves to a job that's the same as the plan incumbent's job.

Note: By default, all the succession plan related alerts are disabled

The succession plans alert template is extensible. This table lists the actions that you can do with the template.

Action Can Do?

Disable the delivered alerts. Yes

Change the text of the subject line and the = Yes
message in the alert.

Change the expressions used in the No
subject line or message.

Delete the delivered template. No

Change the template name or the No
communication method.

Note that though you can add new templates in Alert Composer for succession plans, these new templates won't trigger
any notifications.

Related Topics
« Alerts Composer

How You Send Succession Alerts on Role Change
Effective Date

Your organization may want to notify plan owners about incumbent and candidate role changes after they become
effective. This enables succession plan owners to modify succession plans according to the current roles of the
incumbent or candidates. You need to run the Notify Plan Owners About Candidate and Incumbent Assignment
Changes That Are Now Effective process for this. Note that to run this process, you need to have a role that inherits
the Run Global HR Processes function security privilege.

After You Run the Process

Here's what happens after the Notify Plan Owners About Candidate and Incumbent Assignment Changes That Are
Now Effective process runs successfully:

- Owners receive notifications on the day these role changes become effective if the process is run on a daily
basis:
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o Planincumbent moves to a different role
o A candidate moves to the plan role
o A candidate moves to a role that's different from the plan role

Note: Owners receive notifications only if all these conditions are true:

o Alerts are enabled using the Succession Plan Assignment Change Alert templates in Alerts
Composer.

o Alerts are enabled in the Alerts section of the succession plan.

o Notifications are enabled for the owners in the Owners section of the succession plan.

- When owners view a succession plan, they see banners for the effective role changes of incumbents and

candidates.

Processed notification records for the incumbent and candidate role changes that are older than 90 days are
deleted.

Related Topics
« Submit Scheduled Processes and Process Sets

Succession Management Alerts FAQ

How can | hide the Alerts section in a succession plan?

You use Transaction Design Studio to hide the Alerts section in a succession plan and the check boxes in the section.

10.

V03O UAWNRA

Enable a sandbox and then edit your pages at the Site level.

Open HCM Experience Design Studio.

Select the Transaction Design Studio tab.

From the Action list, select Succession Plans.

Add a rule.

Enter the basic details.

From the Data Source list in the Available Attributes section, select Plan Info.

To hide the Alerts section, set the Alerts attribute value to Not visible.

To hide the check boxes that control alerts for succession plans, set these attributes to Not visible.

o Send alerts when candidates move to roles that are different from the plan role
o Send alerts when candidates move to the plan role
o Send alerts when the incumbent changes roles

Click Save and Close.
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Succession Plan Deep Links

Overview of Succession Plan Deep Links

You can use deep links to navigate directly to the succession plan pages. You can also embed succession plan deep links
in reports or other third party applications and edit or open specific succession plans. Remember that you need to have
access to the Succession Overview page to use the succession plan deep links.

Deep Links for Navigation

You can find the succession plan related deep links on the Deep Links page. Use only the deep links listed in this table
for navigating to a succession plan page.

Deep Link Navigates To
Responsive Succession Overview Succession Overview
Responsive Create Succession Plan Create Succession Plan

The Edit Succession Plan deep link requires the succession plan ID as a parameter. So, we recommend that you don't
use the Edit Succession Plan deep link to navigate to a succession plan page.

Deep Link for Editing Succession Plan

Use the standard deep link URL listed in this table to edit a succession plan based on your security access.

URL Type URL

Standard Deep Link URL https://<hostname>/fscmUI/faces/deeplink?objType=SUCCESSION _
PLAN&action=EDIT&objKey=pPlanId=@{PLAN_ ID}

Note that you need to pass the succession plan ID as a parameter to open the corresponding succession plan.
Remember that you need to have access to the succession plan that you're trying to edit. Also what you can edit on the
succession plan page depends on the type of owner you're for the plan. An owner of Administrator type can perform all
actions on the succession plan. But an owner of Candidate Manager type can't perform certain actions such as adding
plan owners.

This table describes the expected behavior when you try to use the edit succession plan deep link.

61
ORACLE



Talent Management Cloud Chapter 7

Implementing Talent Review and Succession Management Succession Management
User's Access Level Expected Behavior
You have access to the Succession You can edit the succession plan. When you save or cancel your changes, you will go to the Succession
Overview page. Overview page.

You have the privilege to edit a succession
plan.

You have access to the Succession You will go to the Succession Overview page.
Overview page.

But you don't have the privilege to edit a

succession plan.

You don't have access to the Succession You will see a blank page.

Overview page.

But you have the privilege to edit a

succession plan.

You don't have access to the Succession You will see a blank page.

Overview page.

You don't have the privilege to edit a
succession plan.

Related Topics
« Deep Links

Embed the Edit Succession Plan Deep Link in an Analysi

This example shows how to embed the edit succession plan deep link in an Oracle Transactional Business Intelligence
(OTBI) analysis.

This table summarizes key decisions for this scenario.

Decisions to Consider This Example
What type of URL should | embed? Standard Deep Link URL
For which column should | add an Plan ID

interaction?

To edit a succession plan directly from an OTBI analysis:

1. Create an analysis that includes the Plan ID as a column.

ORACLE
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2.
3.
4.

Edit the analysis.
Add a drill-down link for the Plan ID column.
Save the analysis.

Add a Drill-Down Link

VHEWNA

0 03

10.

n.
12.
13.

14.
15.
16.
17.
18.
19.

Edit an existing analysis that has the Plan ID attribute as a column.

Go to the Criteria tab.

In the Plan ID column, click Settings > Column Properties.
Click the Interaction tab.

Select the values indicated in this table.

Field Value
Primary Interaction Default (Drill)
Value Action Links

Click Add Action Link.

You see the New Action Link dialog box.
In the Link Text field, type Edit Plan.
Click the Create New Action icon.

Select Navigate to a Web Page.

You see the Create New Action dialog box.
Enter URL in this format:

Chapter 7
Succession Management

https://<hostname>/fscmUI/faces/deeplink?objType=SUCCESSION PLAN&action=EDIT&objKey=pPlanId=@{PLAN ID}

Click Define Parameters.
Add a new parameter.
In the third row, specify the values shown in this table.

Column Value

Name PLAN ID

Prompt Any suitable value, say Plan ID

Value Column Value and then select the Plan ID column

Select the Hidden check box for all the rows.
Clear the Optional check box for all the rows.
Click Options.

In the Action Options dialog box, select the Open In New Window check box.

Click OK to close the Action Options dialog box.
Click OK to close the Create New Action dialog box.

ORACLE
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20. Click OK to close the New Action Link dialog box.

21. In the Column Properties dialog box of the Plan ID column, click the Data Format tab.

22. Select the Override Default Data Format check box and then specify the value for Treat Number As field as
Number.

| Note: You need to override the default data format only for the Plan ID column.

23. C(lick OK to close the Column Properties dialog box.

Succession Plan Notes

Contextual Notes in Application Pages

Enhance Talent Management application pages using the Notes resource catalog component for persons and objects
using Oracle Page Composer. The Notes feature is similar to the Feedback feature in employee's Person Spotlight and
Performance Document. The Contextual Notes is an extension of the existing Anytime Feedback feature.

You can embed the Notes component on persons and objects using Oracle Page Composer. The Notes component
appears with the title, Feedback or Notes, based on the component configuration, Person Notes and Object Notes.

The following image shows the person notes embedded in the Goal Details page:

= CRECLE

mgdriat

You can create and share notes about employees by configuring the Notes resource catalog component in the following
Talent Management scenarios:

- Notes for an employee in the context of an employee's performance goal
Notes for an employee in the context of an employee's development goal
Notes for an employee in the context of an employee's career development
Notes when you explore roles in the context of role details page
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You can create and share object notes by configuring the Notes resource catalog component in the following Talent
Management scenarios:

- Notes for a talent review meeting
- Notes for a succession plan
- Notes for a talent pool

Related Topics

Add an Object Note to a Succession Plan

Succession plan owners and other HR specialists want to add a note to a succession plan. They also want to restrict
the visibility of the notes to only themselves as the notes may contain confidential information. As an application
implementor, here's what you need to do.

This table summarizes the decisions that must be made.

Decisions to Consider Who Makes the Decision In This Example

Which Notes component can | add to a Application implementor Object notes
succession plan?

Should | change the default visibility setting of = Plan owners and other HR specialists who can Yes. Must change the default Everyone visibility
the object Notes component? access the plan setting to Only Me.

This worked example describes these tasks that need to be done to add the Notes resource catalog component to a
responsive succession plan page:

1. Add the Notes resource catalog component to a succession plan.
2. Create notes for a succession plan.

Before You Add the Notes Component

1. Sign in the application as a user with configuration privileges.
2. Activate a sandbox that has Page Composer tool enabled.

Add a Notes Component

Open a responsive succession plan page.
On the Settings and Actions menu, click Edit Pages.
Ensure that the Edit Layer is Site.
Select the Structure tab.
Select the region where you want to add the note.
In the Source window, select the panelGroupLayout indicated for the page region:
o Plan Info section: Select the panelGroupLayout that encloses all the existing panelCollectionEdit
components.
o Other regions: Select the panelGroupLayout that's at a level lower than the FacetWrapper level.

cCUPpUNA
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In the Source window, click the Add icon.

In the Add Content dialog box, click Add adjacent to Notes.

Close the Add Content dialog box.

In the Source window, select the Notes component and edit its properties.

In the Component Property dialog box, configure the contextual parameters as shown in this table.

—
SO0 ®oN

Parameter Expression

Object Type SUCCESSION_PLAN_ NOTE

Object ID #{bindings.PlanId.inputValue}

12. Configure the display options.

13. Click Apply.

14. Click OK.

15. Click Close to stop editing the page.
16. Publish the sand box.

Create a Note

After the application implementor adds the notes component to a succession plan, it's available in all plans.

A plan owner or an HR Specialist who can access the succession plan can create a note about the succession plan.

Navigate to the Succession Plans overview page.
Edit the plan for which you want to create a note.
Click the Notes component.

In the Notes page, click Add.

From the Who can see my note list, select Only Me.
Add the notes text.

Save the note.

NOUAUWNL

Related Topics
» Add and Hide Components Using Page Composer

Succession Management Integrations

How Succession Plans, Talent Pools, and Talent Reviews
Work Together

Succession plans, talent pools, and talent review meetings together support the development of selected workers to
meet enterprise goals or fill key roles.
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This table shows how you as an HR specialist can access these work areas.

Work Area Navigation

Succession Plans My Client Groups > Succession Plans
Talent Pools My Client Groups > Talent Pools
Talent Review My Client Groups > Talent Review

Succession Plans with Talent Pools

You can select members from talent pools that you own and add them as candidates to succession plans for which you
are a candidate manager. This way, you can enhance your succession planning by selecting appropriate candidates for a
specific job or position.

For example, your current sales director plans to retire after a year. You can plan for the succession in this way:

P WN

Create a succession plan for the Sales Director job.
Create a talent pool of sales managers.
Assign development goals to this talent pool to groom the sales managers for the Sales Director job.

Edit the Sales Director succession plan. Add selected managers from the sales managers' talent pool as
succession plan candidates.

Succession Plans and Talent Pools with Talent Review Meetings

You can use succession plans and talent pools with Talent Review meetings in these ways:

- When you set up a talent review meeting, you can associate succession plans and talent pools that you can

access with the meeting.

When you create a talent review meeting, you can add members of a talent pool that you can access to the
review population of the meeting. This way you can discuss the potential of the talent pool members and rate
them during talent review meetings.

When you conduct the talent review meeting, you can add reviewees to the succession plans and talent pools
associated with the meeting. You can also create new succession plans and talent pools from the meeting
dashboard.

Note: A succession plans super user can access all succession plans. Similarly, a talent pools super user can access all
talent pools.

Related Topics

Talent Review

« Succession Management

Talent Pools
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Configure a Succession Readiness Event to Trigger
Checklist Tasks

This example shows how to use the condition builder to configure the Succession Readiness checklist event. Let's
assume you want to assign these tasks as an administrator to managers when a candidate is ready to move to the role
associated with a succession plan:

- Create training plans for the candidate.
- Add development goals for the candidate.

You need to do these tasks to configure the Succession Readiness checklist event:

1. Create a succession readiness checklist template.
2. Configure the Succession Readiness event.
3. Add tasks for the manager.

Create a Succession Readiness Checklist Template
1. In Setup and Maintenance, go to the Checklist Templates task.
I Tip: You can also use the Checklist Templates quick action available in My Client Groups.

2. Create a checklist template.
3. On the General tab, specify values as indicated in this table.

Field Value

Name Succession Readiness

Status Active

Category A suitable category. For example, Talent Management.
4. Click Save.

Configure the Succession Readiness Event

Click the Actions and Events tab.

In the Configure Events section, click Add.

Select Succession Readiness in the Name list of values.
Click Edit Condition to display the Condition Builder.
Click Create Group.

A WN
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6. Select the values indicated in this table.

Condition Column Value to Select
Attribute Candidate Readiness
Operator Equals

Operand Type Constant

Operand Value Ready Now

7. Click OK to close the Condition Builder.
8. C(lick Save.

Add Tasks for the Manager

1. Click the Tasks tab.
2. Click Add Task to add a task.
3. On the Details sub tab, specify values as indicated in this table.

Field Value

Name Create Training Plan
Status Active

Sequence 1

Performer Line Manager
Owner Line Manager

Task Type Manual Task

4. Click Save and Close.
5. Click Add Task to add the second task.
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6. On the Details sub tab, specify values as indicated in this table.

Field

Name

Status

Sequence

Required

Performer

Owner

Task Type

Application Task

Value

Add Development Goals

Active

Select the check box.

Line Manager

Line Manager

Application Task

Add Development Goal

7. Click Save and Close to return to the Tasks tab.

8. Click Save and Close.

Related Topics

« How You Configure Events in Checklists

ORACLE
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8 Talent Pools

Talent Pools

Talent pools are groups used by organizations to categorize people based on their performance, potential, or functional
area. For example, an organization can group people based on their potential as Early Talent, Promising Talent, and High
Potential.

A person can be a member of more than one talent pool. For example, an employee can be a member of both Promising
Talent and Mid-Management talent pools.

Uses

Your organization can use talent pools for these purposes:

- Track groups of employees with similar characteristics: You can plan the career development of employees
and monitor their progress by grouping them into a talent pool. For example, you can group employees as
campus hires or leadership trainees.

- Plan successors: You can add selected candidates in a succession plan as members of a talent pool. This will
help to groom talent pool members to replace people in key jobs and positions.

- Roll up talent review populations: During a talent review, facilitators can create a talent pool and add
members from the review population. Facilitators can include the talent pool with other review meetings and
include members from that review population. Later, while creating a talent review meeting, facilitators can add
the talent pool members to the review population and evaluate their performance.

Pool Access

If you have the appropriate security privileges, you can access talent pools in these ways:

- Go To My Client Groups > Talent Pools .

- Talent Pool Quick Actions: Select My Client Groups > Show More to access these Quick Actions:

o Create Talent Pool: Use this to create talent pools.

o Add to Talent Pool: Use this to add people who report to you as members of talent pools that you own or
have access to.

- Talent Pool Deep Links: Go to Tools > Deep Links and search for these deep links:

o Responsive Talent Pools Overview: Takes you to the Talent Pools page

o Responsive Create Talent Pool: Takes you to the Create Talent Pool page
- Action in Career Overview page

a. Select My Team > Career Overview .
b. Locate the person to add to the talent pool.
c. From the Actions menu, select Add to Talent Pool.
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- Talent Review work area: Select My Client Groups > Talent Review to create a talent pool while you're
conducting a meeting and associate it with a talent review meeting.

Pool Details

You need to specify these details for a talent pool:

Name: Enter a name that uniquely identifies or describes the pool.

- Status: By default all talent pools are active. You can change the status to inactive if you don't want the talent
pool to be added to a succession plan or talent review meeting.

The person who creates the talent pool is added by default as the owner of the pool. But you can select and add other
owners.

You can also specify these attributes to define the scope of the talent pool:

- Job

- Grade

- Job profile

- Job family
Department
Business unit

Position

Note: These attributes aren't available by default. Your administrator needs to use Transaction Design Studio to show
these attributes.

Members

You can add talent pool members in any of these ways:
- Search for and select employees.
Use the Best-Fit feature to add members to a talent pool.

On the Find Best Fit page, you select a model profile, and specify the priority for each content section. By
default, the best-fit analysis results show all profiles that have 90% match or greater than the selected source
profile. But you can change the percentage of match that you want.

I Note: The Best-Fit feature isn't available on mobile devices.

- Add members from an analysis.

Note: You can see the option to add talent pool members from an analysis only if your administrator has
specified the file path in the Default Reports Folder for Selecting Talent Pool Members profile option.

For each member of the talent pool, you can see these details:

- Status
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Date they were added as a member

You can also identify members who have inactive assignments.

Tip: Did you know that for each member in the pool, you can record your assessment of the risk and impact of the
worker leaving the enterprise? You can't see these attributes by default. Your administrator needs to use Transaction
Design Studio to show these attributes.

Talent Pool Goals

If you're using Career Development, talent pool owners can add development goals to the talent pool. These goals
appear in the development plan of each member of the talent pool.

Talent Pools Super User

You may want to create a talent pools super user who can access all talent pools in your organization without being a
named owner. This ensures that someone can manage the talent pools in your organization even if the named owners
aren't available.

Here's what the talent pools super user can do:

- Create a talent pool.
Delete any talent pool.
- Set any talent pool as inactive.
Manage pool members and owners.
- Add development goals for pool members.

- View profile related data such as Risk of Loss, Impact of Loss, or mobility of pool members based on their
profiles data security if they have been made visible.

Report on all talent pools across the organization.

Related Topics
» How Succession Plans, Talent Pools, and Talent Reviews Work Together

« How You Use Development Goals in Talent Pools
 Guidelines for Using Page Composer

Descriptive Flexfields for Talent Pools

To add company-defined attributes, for example additional information about talent pools or talent pool members, use
descriptive flexfields for the talent pools entity.

Defining Descriptive Flexfield Segments

Use the Manage Descriptive Flexfields task to define a segment for a descriptive flexfield for talent pools. You can add
more information related to these talent entities, such as the talent pool details.

There are two descriptive flexfields available for talent pools.
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Descriptive Flexfield Description
HRT_POOLS_B Fields for talent pool details that you enter in the Additional Information section on the Create Talent

Pool: Enter Details page.

HRT_POOL_MEMBERS Fields for member details that appear on the Create Talent Pool: Select Members page in the Additional
Information column.

Related Topics
« Overview of Descriptive Flexfields

« Overview of Flexfields

Overview of Talent Pool Deep Links

You can use deep links to navigate directly to the talent pool pages. You can also embed talent pool deep links in reports
or other third party applications and edit or open specific talent pools. Remember that you need to have access to the
Succession Overview page to use the talent pool deep links.

Deep Links for Navigation

You can find the talent pool related deep links on the Deep Links page. Use only the deep links listed in this table for
navigating to a talent pool page.

Deep Link Navigates To
Responsive Talent Pools Overview Talent Pools page
Responsive Create Talent Pool Create Talent pool page

The Edit Talent pool deep link requires the talent pool ID as a parameter. So we recommend that you don't use this deep
link to navigate to a talent pool page.

Deep Links for Editing Talent pool Pages
Use the standard deep link URL listed in the table to edit talent pool pages.
URL Type URL

Standard Deep Link URL https://<hostname>/fscmUI/faces/deeplink?objType=TALENT _
POOL&action=EDIT&objKey=pPoolId=@{POOL_ID}
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Note that you need to pass the talent pool ID as a parameter to open the corresponding talent pool page. Also
remember that you need to have access to the talent pool that you're trying to edit.

This table describes the expected behavior when you try to use the edit talent pool deep link.

User's Access Level Expected Behavior
You have access to the Succession You can edit the talent pool. When you save or cancel your changes, you will go to the Succession
Overview page. Overview page.

You have the privilege to edit a talent pool.

You have access to the Succession You will see a blank page.
Overview page.

But you don't have the privilege to edit a

talent pool.

You don't have access to the Succession You will see a blank page.
Overview page.

But you have the privilege to edit a talent

pool.

You don't have access to the Succession You will see a blank page.
Overview page.

You don't have the privilege to edit a talent
pool.

Related Topics
« Deep Links

Embed the Edit Talent Pool Deep Link in an Analysis

This example shows how to embed the edit talent pool deep link in an Oracle Transactional Business Intelligence (OTBI)
analysis.

This table summarizes key decisions for this scenario.

Decisions to Consider This Example
What type of URL should | embed? Standard Deep Link URL
For which column should | add an Pool ID

interaction?

75
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa22a&id=s20059100

Talent Management Cloud Chapter 8
Implementing Talent Review and Succession Management Talent Pools

To edit a talent pool directly from an OTBI analysis:

1. Create an analysis that includes the Pool ID as a column.
2. Edit the analysis.

3. Add adrill-down link for the Pool ID column.

4. Save the analysis.

Add a Drill-Down Link

1. Edit an existing analysis that has the Pool ID attribute as a column.
2. Go to the Criteria tab.
3. Inthe Pool ID column, click Settings > Column Properties .
4. C(lick the Interaction tab.
5. Select the values indicated in this table.
Field Value
Primary Interaction Default (Drill)
Value Action Links

6. Click Add Action Link.

You see the New Action Link dialog box.
7. Inthe Link Text field, type Edit Pool.
Click the Create New Action icon.
9. Select Navigate to a Web Page.

&

You see the Create New Action dialog box.
10. Enter URL in this format:

https://<hostname>/fscmUI/faces/deeplink?objType=SUCCESSION PLAN&action=EDIT&objKey=pPoolId=@{POOL ID}

11. Click Define Parameters.
12. Add a new parameter.
13. In the third row, specify the values shown in this table.

Column Value

Name POOL_ID

Prompt Any suitable value, say Pool ID

Value Column Value and then select the Pool ID column

14. Select the Hidden check box for all the rows.
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15.
16.
17.
18.
19.
20.
21.
22.

23,

Clear the Optional check box for all the rows.

Click Options.

In the Action Options dialog box, select the Open In New Window check box.

Click OK to close the Action Options dialog box.

Click OK to close the Create New Action dialog box.

Click OK to close the New Action Link dialog box.

In the Column Properties dialog box of the Pool ID column, click the Data Format tab.

Select the Override Default Data Format check box and then specify the value for Treat Number As field as
Number.

Note: You need to override the default data format only for the Pool ID column.

Click OK to close the Column Properties dialog box.
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9 Personalization Using Transaction Design
Studio

Use Transaction Design Studio to Configure Field
Displays

Use the Transaction Design Studio (TDS) to configure transactions and pages for responsive applications. TDS is
available within the HCM Experience Design Studio. You can control the visibility of attributes that are displayed either
as Delivered or Enabled, and the availability of fields and sections of a transaction based on the user's role, person's
business unit, or legal employer.

By default, the responsive pages display the frequently used attributes and hide the less frequently used attributes. Use
Page Composer to personalize the responsive pages and display the attributes and tabs delivered within the feature.
Here's how you start HCM Experience Design Studio:

1. Signin to the application as Human Capital Management Application Administrator with Access HCM Page
Configurator (HRC_ACCESS_HCM_TRANSACTION_CONFIGURATOR_PRIV) privilege. This privilege provides
you access to TDS in HCM Experience Design Studio.

2. Enable a sandbox to compose data for configuring business objects. On the Home page, click the HCM
Experience Design Studio quick action under the My Client Groups tab.

3. Under Settings and Actions, click Edit Pages .

4. Select the site layer and click OK.

Related Topics
» Overview of Page Modification

How You Configure Talent Review Pages Using
Transaction Design Studio

Use Transaction Design Studio (TDS) to create rules to configure Talent Review pages. You can include or hide sections
and fields as needed by your organization.

Actions

This table shows the actions that you can use to configure Talent Review pages and the page for which the action
applies.

Action Page

Prepare Review Content Prepare Review Content
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Action Page
Talent Review Notes Notes

Did you know that you can create multiple rules for an action? But remember that you can have only one active rule for
any action at a time.

Prepare Review Content Action

To control the attributes that meeting reviewers can see while preparing review content, create a rule for the Prepare
Review Content action in TDS. You can specify a role criteria for the rules that you create using this action.

You can hide or display these attributes in the Page Attributes section:

- The photo of the employee being reviewed
Data submission deadline
Data validity guideline
- The Display list of values used to filter the employees listed
Meeting date
Meeting instructions
- View Notes action for the employee in the Ratings section

In the Available Attributes section, you can hide or display the name of the employee's manager.

Talent Review Notes Action

The Notes page of a Talent Review meeting has two sections: Meeting Notes and Review Population Notes. To hide or
display these sections of the Notes page, create a rule for the Talent Review Notes action in TDS and then specify the
visibility for the corresponding attributes. You can specify a role criteria for the rules that you create using this action.

Related Topics
« HCM Experience Design Studio

How You Configure Succession Plan Pages Using
Transaction Design Studio

Use the Succession Plans action in Transaction Design Studio to create rules to configure Succession Management
pages. When you create rules using this action, you can do these tasks:

- Specify a role criteria.
Hide or show fields.
Mark some fields as required to be filled.

For example, your organization may not want private succession plans. You can create a rule for the Succession Plans
action and then hide the Private check box.
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Succession Plans Action

When you create a rule, you select the data source and then configure the attributes.

This table lists the attributes for the Plan Info data source.

Attribute Field or Section on Succession Make Required/ Not Required Make Visible/Not Visible
Plan Page
Add Talent Pool Members Talent Pool Members option in No Yes

the Add menu

Add to Talent Pool Check boxes and Add to Talent No Yes
Pool button for adding selected
candidates as talent pool members

Alerts Alerts section No Yes
Banner for Incumbent Changing The banner shown in the Plan Info =~ No Yes
Role section when the plan incumbent's

role changes

Note:
Applies only for Incumbent type
succession plans

Best-Fit Candidates Option to select Best-Fit No Yes
candidates in the Add menu

Business Unit Business unit for which the Yes Yes
succession plan is created

Created By Created By No Yes
Note:
This field isn't visible by default.

Creation Date Creation Date No Yes
Note:

This field isn't visible by default.

Department Department for which the Yes Yes
succession plan is created

Description Description Yes Yes
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Attribute

Estimated Remaining Months

External Candidate

Impact of Loss

Incumbent Department

Incumbent Job

Incumbents

Job Grade

Plan Info Descriptive Flexfields

ORACLE

Field or Section on Succession
Plan Page

Estimated Remaining Months
field for the plan incumbent

Note:

- Applies only for Incumbent
type succession plans

This field isn't visible by
default.

Menu option for adding external
candidates

Impact of Loss field for the plan
incumbent

Note:

Applies only for Incumbent
type succession plans

This field isn't visible by
default.

Department of the succession
plan's incumbent

Note:
Applies only for Incumbent type
succession plans

Job of the succession plan's
incumbent

Note:
Applies only for Incumbent type
succession plans

Incumbents section of the
succession plan

Job grade for which the succession
plan is created

Descriptive flexfields in the Plan
Info section

Make Required/ Not Required

Yes

No

Yes

Note:

Only users who can edit the
impact of loss value see the
Required indicator.

No

No

No

Yes

No

Chapter 9
Personalization Using Transaction Design Studio

Make Visible/Not Visible

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes
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Attribute

Privacy

Reason for Departure

Risk of Loss

Send alerts when candidates move
to roles that are different from the
plan role

Send alerts when candidates move
to the plan role

Send alerts when the incumbent
changes roles

Field or Section on Succession
Plan Page

Note:
These descriptive flexfields
aren't visible by default.

Private check box

Chapter 9

Personalization Using Transaction Design Studio

Make Required/ Not Required

No

Reason for Departure field for the Yes

plan incumbent

Note:

- Applies only for Incumbent

type succession plans

This field isn't visible by
default.

Risk of Loss field for the plan
incumbent

Note:

- Applies only for Incumbent

type succession plans

This field isn't visible by
default.

Check box in the Alerts section

Check box in the Alerts section

Check box in the Alerts section

Yes

Note:

Only users who can edit the risk
of loss value see the Required
indicator.

No

No

No

Make Visible/Not Visible

Yes

Yes

Yes

Yes

Yes

Yes

To configure the Candidates section of the succession plan, select the Candidates data source. This table lists the
attributes for the Candidates data source.

ORACLE
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Attribute

All Other Plans

All Other Plans Link

Banner for Candidate Changing
Role

Banner for Candidate Moving to

Incumbent Role

Impact of Loss

Interim Successor

Job

Other Accessible Plans

Other Accessible Plans Link

Plan Candidates Descriptive
Flexfields

ORACLE

Field or Section on Succession
Plan Page

Count of all other succession plans
that the person is also a candidate
in

Note:
This field isn't visible by default.

Count link that opens a page that
lists all other succession plans that
the person is also a candidate in

Banner shown for a candidate
when the candidate's role changes
to a role different from the plan
role

Banner shown for a candidate
when the candidate's role changes
to the incumbent's role

Impact of Loss field for the
candidate

Note:
This field isn't visible by default.

A label that identifies the candidate
as an interim successor

Candidate's job

Count of all other accessible
succession plans the personis a
candidate in

Count link that opens a page that
lists all other accessible succession
plans that the person is also a
candidate in

Descriptive flexfields of the
Candidates section of the
succession plan

Make Required/ Not Required

No

No

No

No

Yes

Note:

Only users who can edit the
impact of loss value see the
Required indicator.

No

No

No

No

No

Chapter 9
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Make Visible/Not Visible

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes
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Attribute Field or Section on Succession Make Required/ Not Required Make Visible/Not Visible
Plan Page
Note:

These descriptive flexfields
aren't visible by default.

Ranking Candidate's ranking Yes Yes
Readiness Candidate's readiness level Yes Yes
Risk of Loss Risk of Loss field for the candidate Yes Yes
Note: Note:
This field isn't visible by default. Only users who can edit the risk
of loss value see the Required
indicator.
Status Candidate's status No Yes
Willing to Relocate Candidate's willingness to relocate = No Yes
Note:

This field isn't visible by default.

Related Topics
« HCM Experience Design Studio

How You Configure Talent Pool Pages Using Transaction
Design Studio

Use the Talent Pools action in Transaction Design Studio (TDS) to create rules to configure Talent Pool pages as needed
by your organization. When you create rules using this action, you can do these configurations:

- Specify the role criteria.
- Show or hide fields.
- Mark some fields as required to be filled.

When you create a rule for the Talent Pools action, in the Available Attributes section, you select the data source and
then configure the attributes.
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Pool Info Data Source Attributes

You select the Pool Info data source to configure the Pool Info and Development Goals sections of the talent pool.

This table lists the attributes for the Pool Info data source.

Attribute

Add Development Goal

Best-Fit Members

Business Unit

Department

Description

Development Goals Section

Job

Job Family

ORACLE

Field on Talent Pool Page

Add button for adding a
development goal to the talent
pool

Best-Fit Members option in the
Add menu of the Members section

Business unit for which the talent
pool is created

Note:
This field isn't visible by default.

Department for which the talent
pool is created

Note:
This field isn't visible by default.

Description

The section in the talent pool for
adding or viewing development
goals

Job for the talent pool

Note:
This field isn't visible by default.

Job family for which the talent pool
is created

Note:
This field isn't visible by default.

Make Required/ Not Required

No

No

Yes

Yes

Yes

No

Yes

Yes

Chapter 9
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Make Visible/Not Visible

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes
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Attribute

Job Grade

Pool Info Descriptive Flexfields

Position

Remove Development Goal

Field on Talent Pool Page

Job grade for which the talent pool
is created

Note:
This field isn't visible by default.

Descriptive flexfields in the Pool
Info section of the talent pool

Note:
These flexfields aren't visible by
default.

Position

Note:
This field isn't visible by default.

Remove icon for a development
goal

Members Data Source Attributes

You select the Members data source in the Available Attributes section to configure the Members section of the talent

pool page.

This table lists the attributes for the Members data source.

Attribute

Impact of Loss

Job

Member Since

ORACLE

Field on Talent Pool Page

Impact of Loss

Note:
This field isn't visible by default.

Member's job

Field that shows the date the
member was added to the talent
pool

Make Required/ Not Required

Yes

No

Yes

No

Make Required/ Not Required

Yes

No

Chapter 9
Personalization Using Transaction Design Studio

Make Visible/Not Visible

Yes

Yes

Yes

Yes

Make Visible/Not Visible

Yes

Yes

Yes
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Attribute

Pool Members Descriptive
Flexfields

Risk of Loss

Status

Willing to Relocate

Field on Talent Pool Page Make Required/ Not Required

Descriptive flexfields in the No
Members section of the talent pool

Note:
These flexfields aren't visible by
default.

Risk of Loss Yes

Note:
This field isn't visible by default.

Member's status No
Member's willingness to relocate No
Note:

This field isn't visible by default.

Pool Member List Data Source Attributes

You select the Pool Member List data source in the Available Attributes section to configure the Members section of
the Add from Talent Pool page. This page opens when candidate managers select the Talent Pool Members option in
the Add menu of the Candidates section of a succession plan.

Chapter 9

Personalization Using Transaction Design Studio

Make Visible/Not Visible

Yes

Yes

Yes

Yes

This table lists the attributes for the Pool Member List data source. You can set the value of these attributes to Visible
or Not visible according to your organization's requirements.

Attribute

Business Unit

Grade

Manager

Member Since

Status

ORACLE

Field shown on Add from Talent Pool Page

Business unit of the member

Member's grade

Manager of the member

The date the member was added to the talent pool

Note:
This field isn't visible by default.

Member's status
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Attribute Field shown on Add from Talent Pool Page
Related Topics

« HCM Experience Design Studio
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